Quantifiler® Duo DNA Quantification Kit

User’s Manual
Contents

Preface

How to Use This Guide ....................................................... v
Safety ................................................................. vii
How to Obtain More Information ................................. xi
How to Obtain Support .................................................... xi

Chapter 1 Overview

Product Overview ......................................................... 1-2
Chemistry Overview ...................................................... 1-3
Instrument Overview ..................................................... 1-7
SDS Software Overview ................................................ 1-8
Real-Time Data Analysis ............................................... 1-9
Quantifiler® Duo Kit Workflow .................................... 1-15
Materials and Equipment ............................................... 1-16

Chapter 2 Software Setup

Overview ................................................................. 2-2
Starting the 7500 Real-Time PCR System ..................... 2-3
About Plate Documents ............................................... 2-6
Setting Up a Plate Document .................................... 2-8
Setting Up a Plate Document Template ....................... 2-26

Chapter 3 PCR Amplification

Preparing the DNA Quantification Standards .................. 3-2
Preparing the Reactions .............................................. 3-5
Running the Reactions ............................................... 3-7
Chapter 4  Data Analysis and Results
Analyzing the Plate Document ........................................ 4-2
Viewing Results .............................................................. 4-4

Chapter 5  Interpretation of Results
Checking Analysis Settings ............................................. 5-2
Examining the Standard Curve ......................................... 5-3
Troubleshooting the Standard Curve ................................. 5-5
Using the Internal PCR Control System .............................. 5-13
Troubleshooting Amplification Plots ................................. 5-15
Assessing Quantity .......................................................... 5-19
Calculating Male : Female DNA Ratio ............................... 5-20
Improving Assay Performance .......................................... 5-20
Assessing Sensitivity and Results .................................... 5-20
Assessing and Troubleshooting False Positive Results ............ 5-22
Preventing PCR Contamination ........................................ 5-23

Chapter 6  Experiments and Results
Overview ................................................................. 6-2
Developmental Validation ............................................... 6-3

Bibliography

Index
Preface

This preface contains:

How to Use This Guide .................................................. v
Safety ........................................................................ vii
How to Obtain More Information .............................. xi
How to Obtain Support .................................................. xi

How to Use This Guide

Purpose of This Guide

The Quantifiler® Duo DNA Quantification Kit User’s Manual provides information about and instructions for using the Quantifiler® Duo DNA Quantification Kit.

Audience

This manual is intended for scientists who use the Quantifiler® Duo DNA Quantification Kit for the quantification of human DNA extracted from a variety of sample types. It requires familiarity with the 7500 Real-Time PCR System and 7500 SDS software.

Text Conventions

This guide uses the following conventions:

- **Bold** indicates user action. For example:
  Type 0, then press **Enter** for each of the remaining fields.

- *Italic* text indicates new or important words and is also used for emphasis. For example:
  Before analyzing, *always* prepare fresh matrix.

- A right arrow bracket (>) separates successive commands you select from a drop-down or shortcut menu. For example:
  Select **File > Open > Spot Set**.
  Right-click the sample row, then select **View Filter > View All Runs**.
Preface

User Attention Words
Two user attention words appear in Applied Biosystems user documentation. Each word implies a particular level of observation or action as described below:

Note: Provides information that may be of interest or help but is not critical to the use of the product.

IMPORTANT! Provides information that is necessary for proper instrument operation, accurate chemistry kit use, or safe use of a chemical.

Examples of the user attention words appear below:

Note: The size of the column affects the run time.

Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection to the database, you need a valid Oracle user ID and password.

IMPORTANT! You must create a separate Sample Entry Spreadsheet for each 96-well plate.

Safety Alert Words
Safety alert words also appear in user documentation. For more information, see “Safety Alert Words” on page vii.

Pull-out Chapters
This User Manual contains individually bound chapters (Chapter 2 through Chapter 6) that the user can pull out of the binder to use in the lab.
Safety

Safety Alert Words

Four safety alert words appear in Applied Biosystems user documentation at points in the document where you need to be aware of relevant hazards. Each alert word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular level of observation or action, as defined below:

IMPORTANT! – Indicates information that is necessary for proper instrument operation, accurate chemistry kit use, or safe use of a chemical.

⚠️ CAUTION – Indicates a potentially hazardous situation that, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.

⚠️ WARNING – Indicates a potentially hazardous situation that, if not avoided, could result in death or serious injury.

⚠️ DANGER – Indicates an imminently hazardous situation that, if not avoided, will result in death or serious injury. This signal word is to be limited to the most extreme situations.

Chemical Hazard Warning

⚠️ WARNING CHEMICAL HAZARD. Some of the chemicals used with Applied Biosystems instruments and protocols are potentially hazardous and can cause injury, illness, or death.
Chemical Safety Guidelines

To minimize the hazards of chemicals:

- Read and understand the Material Safety Data Sheets (MSDS) provided by the chemical manufacturer before you store, handle, or work with any chemicals or hazardous materials. (See “About MSDSs.”)
- Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing). For additional safety guidelines, consult the MSDS.
- Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood). For additional safety guidelines, consult the MSDS.
- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer’s cleanup procedures as recommended on the MSDS.
- Comply with all local, state/provincial, or national laws and regulations related to chemical storage, handling, and disposal.

About MSDSs

Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with shipments of hazardous chemicals to new customers. They also provide MSDSs with the first shipment of a hazardous chemical to a customer after an MSDS has been updated. MSDSs provide the safety information you need to store, handle, transport, and dispose of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to replace the appropriate MSDS in your files.

Obtaining MSDSs

The MSDS for any chemical supplied by Applied Biosystems is available to you free 24 hours a day. To obtain MSDSs:

1. Go to www.appliedbiosystems.com, click Support, then click MSDS Search.
2. In the Keyword Search field, enter the chemical name, product name, MSDS part number, or other information that appears in the MSDS of interest. Select the language of your choice, then click Search.
3. Find the document of interest, right-click the document title, then select any of the following:
   - **Open** – To view the document
   - **Print Target** – To print the document
   - **Save Target As** – To download a PDF version of the document to a destination that you choose

**Note:** For the MSDSs of chemicals not distributed by Applied Biosystems, contact the chemical manufacturer.

---

**Chemical Waste Hazard**

**WARNING** **CHEMICAL WASTE HAZARD.** Some wastes produced by the operation of the instrument or system are potentially hazardous and can cause injury, illness, or death.

**Chemical Waste Safety Guidelines**

To minimize the hazards of chemical waste:

- Read and understand the Material Safety Data Sheets (MSDSs) provided by the manufacturers of the chemicals in the waste container before you store, handle, or dispose of chemical waste.

- Provide primary and secondary waste containers. (A primary waste container holds the immediate waste. A secondary container contains spills or leaks from the primary container. Both containers must be compatible with the waste material and meet federal, state, and local requirements for container storage.)

- Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing). For additional safety guidelines, consult the MSDS.

- Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood). For additional safety guidelines, consult the MSDS.

- Handle chemical wastes in a fume hood.

- After emptying the waste container, seal it with the cap provided.

- Dispose of the contents of the waste tray and waste bottle in accordance with good laboratory practices and local, state/provincial, or national environmental and health regulations.
Waste Disposal

If potentially hazardous waste is generated when you operate the instrument, you must:

- Characterize (by analysis if necessary) the waste generated by the particular applications, reagents, and substrates used in your laboratory.
- Ensure the health and safety of all personnel in your laboratory.
- Ensure that the instrument waste is stored, transferred, transported, and disposed of according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal limitations may apply.

Biological Hazard Safety

WARNING BIOHAZARD. Biological samples such as tissues, body fluids, and blood of humans and other animals have the potential to transmit infectious diseases. Follow all applicable local, state/provincial, and/or national regulations. Wear appropriate protective eyewear, clothing, and gloves. Read and follow the guidelines in these publications:

- U.S. Department of Health and Human Services guidelines published in Biosafety in Microbiological and Biomedical Laboratories (stock no. 017-040-00547-4; http://bmbl.od.nih.gov)

Additional information about biohazard guidelines is available at: http://www.cdc.gov
How to Obtain More Information

Related Documentation


- User Bulletin: Quantifiler® Kits Validation Using SDS Software v1.2.3 on the Applied Biosystems 7500 Real-Time PCR System and the ABI PRISM® 7000 Sequence Detection System (PN 4374659 Rev. B)


Note: For additional documentation, see “How to Obtain Support” below.

Send Us Your Comments

Applied Biosystems welcomes your comments and suggestions for improving its user documents. You can e-mail your comments to:

**techpubs@appliedbiosystems.com**

How to Obtain Support

For the latest services and support information for all locations, go to [http://www.appliedbiosystems.com](http://www.appliedbiosystems.com), then click the link for Support.

At the Support page, you can:

- Obtain worldwide telephone and fax numbers to contact Applied Biosystems Technical Support and Sales facilities
- Search through frequently asked questions (FAQs)
- Submit a question directly to Technical Support
- Order Applied Biosystems user documents, MSDSs, certificates of analysis, and other related documents
- Download PDF documents
- Obtain information about customer training
- Download software updates and patches
Overview

This chapter covers:

Product Overview .............................................1-2
Chemistry Overview .......................................1-3
Instrument Overview .....................................1-7
SDS Software Overview ..................................1-8
Real-Time Data Analysis .................................1-9
Quantifiler® Duo Kit Workflow .......................1-15
Materials and Equipment ...............................1-16
Product Overview

**Purpose**
The Quantifiler® Duo DNA Quantification Kit (PN 4387746) is designed to simultaneously quantify the total amount of amplifiable human DNA and human male DNA in a sample. The results obtained using the kit can aid in determining:

- If the sample contains sufficient human DNA and/or human male DNA to proceed with short tandem repeat (STR) analysis.
- The amount of sample to use in STR analysis applications.
- The relative quantities of human male and female DNA in a sample that can assist in the selection of the applicable STR chemistry.
- If PCR inhibitors are present in a sample that may require additional purification before proceeding to STR analysis.

**Product Description**
The Quantifiler® Duo DNA Quantification Kit contains all the necessary reagents for the amplification, detection, and quantification of a human-specific DNA target and a human male-specific DNA target.

The reagents are designed and optimized for use with the Applied Biosystems 7500 Real-Time PCR System and SDS Software v1.2.3.
Chemistry Overview

Assay Overview
The DNA quantification assay combines three 5′ nuclease assays:
- A target-specific human DNA assay
- A target-specific human male DNA assay
- An internal PCR control (IPC) assay

Target-Specific Assay Components
The target-specific assays consist of:
- Two primers for amplifying human DNA
- One TaqMan® MGB probe labeled with VIC® dye for detecting the amplified human target sequence
- Two primers for amplifying human male DNA
- One TaqMan® MGB probe labeled with FAM™ dye for detecting the human male amplified target sequence

About the Targets
Table 1-1 provides information about the targets of PCR amplification in the Quantifiler® Duo DNA Quantification Kit.

<table>
<thead>
<tr>
<th>Target</th>
<th>Gene Target</th>
<th>Location</th>
<th>Amplicon Length</th>
<th>Gene ID</th>
<th>Ploidy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human Target</td>
<td>Ribonuclease P RNA Component H1 (RPPH1)</td>
<td>14q11.2</td>
<td>140 bases</td>
<td>85495</td>
<td>Diploid</td>
</tr>
<tr>
<td>Human Male Target</td>
<td>Sex-determining region Y (SRY)</td>
<td>Yp11.3</td>
<td>130 bases</td>
<td>6736</td>
<td>Haploid</td>
</tr>
</tbody>
</table>

IPC Assay Components
The IPC assay consists of:
- IPC template DNA (a synthetic sequence not found in nature)
- Two primers for amplifying the 130 base IPC template DNA
- One TaqMan® MGB probe labeled with NED™ dye for detecting the amplified IPC DNA
Chapter 1 Overview

About the Probes

The TaqMan® MGB probes contain:

- A reporter dye (FAM™, VIC® or NED™ dye) linked to the 5’ end of the probe
- A minor groove binder (MGB) at the 3´ end of the probe
  This modification increases the melting temperature (T_m) without increasing probe length (Afonina et al., 1997; Kutyavin et al., 1997), to allow for the design of shorter probes.
- A nonfluorescent quencher (NFQ) at the 3’ end of the probe

5’ Nuclease Assay Process

The 5’ nuclease assay process (Figures 1-1 through 1-5) takes place during PCR amplification. This process occurs in every cycle, and it does not interfere with the exponential accumulation of product.

Figure 1-1 Legend for 5’ nuclease assay process figures

During PCR, the TaqMan® MGB probe anneals specifically to a complementary sequence between the forward and reverse primer sites (Figure 1-2).

When the probe is intact (Figures 1-2 and 1-3), the proximity of the reporter dye to the quencher dye results in suppression of the reporter fluorescence primarily by Förster-type energy transfer (Förster, 1948; Lakowicz, 1983).

Figure 1-2 Polymerization
AmpliTaq Gold® DNA polymerase cleaves only probes that are hybridized to the target (Figure 1-4). Cleavage separates the reporter dye from the quencher dye, resulting in increased fluorescence by the reporter. This increase in fluorescence signal occurs only if the target sequence is complementary to the probe and is amplified during PCR. Because of these requirements, nonspecific amplification is not detected.

Polymerization of the strand continues, but because the 3’ end of the probe is blocked, there is no extension of the probe during PCR (Figure 1-5).
Human DNA Standard

The human DNA used to generate the DNA quantification standards dilution series consists of pooled human male genomic DNA. As such, the performance of the Quantifiler® Duo assay is validated and the results are optimized for use with this DNA standard. The use of an alternate DNA standard may result in the reporting of different concentration values for the unknown samples. Use of an alternate DNA standard should be supported by appropriate validation studies.
Instrument Overview

Fluorescence Detection

Detection on the Applied Biosystems 7500 Real-Time PCR System

1. A tungsten-halogen lamp directs light to each well on the reaction plate. The light excites the fluorescent dyes in each well of the plate.

2. During the run, the CCD camera detects the fluorescence emission.

3. The SDS software obtains the fluorescence emission data from the CCD camera and applies data analysis algorithms.

Figure 1-6   Applied Biosystems 7500 Real-Time PCR System
SDS Software Overview

The Applied Biosystems 7500 Real-Time PCR System is calibrated with several dyes including, FAM™, SYBR® Green, JOE™, VIC®, TAMRA™, NED™, CY3, ROX™, TEXAS RED and CY5.

The 7500 system uses the data obtained from the pure-dye calibration to distinguish the individual contribution of each dye in the collective fluorescence, as gathered by the instrument during a run. After each run, the SDS software receives raw spectra-signal data for each reading. To make sense of the raw data, the software determines the contribution of each fluorescent dye used in the sample by comparing the raw spectra data to a set of pure dye standards contained in the pure spectra file. When a plate is saved after analysis, the software stores the pure spectra information with the collected fluorescent data for that experiment.

Figure 1-7 shows the emission spectrum for each dye, and the filters and wavelengths at which each dye is read.

![Figure 1-7 Example of an emission spectrum](image-url)
Normalization of Reporter Signals

The SDS software displays cycle-by-cycle changes in normalized reporter signal ($R_n$). The SDS software normalizes each reporter signal by dividing it by the fluorescent signal of the passive reference dye. Because the passive reference is one component of the PCR master mix, it is present at the same concentration in all wells of the reaction plate. By normalizing the reporter signal using the passive reference, the software can account for minor variations in signal caused by pipetting inaccuracies and make better well-to-well comparisons of the reporter signal.

Real-Time Data Analysis

The 7500 Real-Time PCR instrument can be used to determine the relative quantity of a target nucleic acid sequence in a sample by analyzing the cycle-to-cycle change in fluorescent signal as a result of amplification (Figure 1-8).

Amplification Plot Example

When using TaqMan® probes with the 7500 Real-Time PCR instrument, the fluorescent signal (or normalized reporter, $R_n$) increases as the amount of specific amplified product increases. Figure 1-8 shows the amplification of PCR product in a plot of $R_n$ vs. cycle number during PCR. This amplification plot contains three distinct phases that characterize the progression of the PCR.
Chapter 1  Overview

Phases of Amplification

Initially, R_0 appears as a flat line because the fluorescent signal is below the detection limit of the sequence detector.

Phase 1: Geometric (Exponential)

Upon detection, the signal increases in direct proportion to the increase of PCR product. As PCR product continues to increase, the ratio of AmpliTaq® Gold polymerase to PCR product decreases.

During the geometric phase, amplification is characterized by a high and constant efficiency. Amplification occurs between the first detectable rise in fluorescence and the beginning of the linear phase. During the geometric phase, a plot of DNA concentration versus cycle number on a log scale should approximate a straight line with a slope. Typically, the real-time PCR system is sufficiently sensitive to detect at least 3 cycles in the geometric phase, assuming reasonably optimized PCR conditions.
Phase 2: Linear

During the linear phase, the slope of the amplification plot decreases steadily. At this point, one or more components of the PCR has decreased below a critical concentration, and the amplification efficiency begins to decrease. This phase is termed linear because amplification approximates an arithmetic progression, rather than a geometric increase. Because amplification efficiency is continually decreasing during the linear phase, the amplification curves exhibit low precision.

Phase 3: Plateau

The amplification plot achieves the plateau phase when the PCR stops, the $R_n$ signal remains relatively constant, and the template concentration reaches a plateau at about $10^{-7}$ M (Martens and Naes, 1989).
Relationship of Amplified PCR Product to Initial Template Concentration

Because of the progressive cleavage of TaqMan® fluorescent probes during the PCR, as the concentration of amplified product increases in a sample, so does the Rn value. The following equation describes the relationship of amplified PCR product to initial template during the geometric phase:

\[ N_c = N(1 + E)^c \]

where \( N_c \) is the concentration of amplified product at any cycle, \( N \) is the initial concentration of target template, \( E \) is the efficiency of the system, and \( c \) is the cycle number.

For example, with the dilutions of RNase P target in the TaqMan® RNase P Instrument Verification Plate, the ratio of template concentration to detectable signal is preserved in the geometric phase for all dilutions (Figure 1-9). As the rate of amplification approaches a plateau, the amount of product is no longer proportional to the initial number of template copies.

Figure 1-9 Amplification plot from a real-time run of an RNase P Instrument Verification Plate
About the Threshold
The SDS software uses a threshold setting to define the level of detectable fluorescence. Based on the number of cycles required to reach the threshold, the SDS software can compare test samples quantitatively: A sample with a higher starting template copy number reaches the threshold earlier than a sample with a lower starting template copy number.

About the Threshold Cycle
The threshold cycle (C_T) for a specified amplification plot occurs when the fluorescent signal increases beyond the value of the threshold setting. The C_T value depends on:
- Starting template copy number
- Efficiency of DNA amplification by the PCR system

How C_T Values Are Determined
To determine the C_T value, the SDS software uses the R_n values collected from a predefined range of PCR cycles called the baseline (the default baseline occurs between cycles 3 and 15 on the 7500 Real-Time PCR instrument):
1. The software generates a baseline-subtracted amplification plot of ΔR_n versus cycle number.
2. An algorithm defines the cycle where the ΔR_n value crosses the threshold setting as the threshold cycle (C_T).

Relationship of Threshold Cycles to Initial Template Amount
The following equation describes the exponential amplification of the PCR:

\[ X_n = X_m (1 + E_x)^{n-m} \]

where:
- \( X_n \) = number of target molecules at cycle n (so that n > m)
- \( X_m \) = number of target molecules at cycle m
- \( E_x \) = efficiency of target amplification (between 0 and 1)
- \( n - m \) = number of cycles elapsed between cycle m and cycle n
Amplicons designed and optimized according to Applied Biosystems guidelines (amplicon size <150 bp) have amplification efficiencies that approach 100%. Therefore $E_X = 1$ so that:

$$X_n = X_m(1 + 1)^{n - m}$$
$$= X_m(2)^{n - m}$$

To define the significance in amplified product of one thermal cycle, set $n - m = 1$ so that:

$$X_n = X_m(2)^1$$
$$= 2X_m$$

Therefore, each cycle in the PCR reaction corresponds to a two-fold increase in product. Likewise, a difference in $C_T$ values of 1 equates to a two-fold difference in initial template amount.
Quantifiler® Duo Kit Workflow

Use of the Quantifiler® Duo Kit involves the following workflow:

1. **Software Setup**
2. **PCR Amplification**
3. **Data Analysis**
4. **Interpretation of Results**
Chapter 1  Overview

Materials and Equipment

Kit Contents and Storage  Each Quantifiler® Duo DNA Quantification Kit contains materials sufficient to perform 400 reactions at a 25-µL reaction volume. Store the entire kit at −15 °C to −25 °C upon receipt. Store the kit at 2°C to 8°C after first thaw, as described in Table 1-2.

Table 1-2  Quantifiler® Duo DNA Quantification Kit contents

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Contents</th>
<th>Quantity</th>
<th>Storage</th>
</tr>
</thead>
</table>
| Quantifiler® Duo Primer Mix | • Primer pairs for amplification of RPPH1, SRY and IPC.  
|                             | • TaqMan® probes for RPPH1, SRY and IPC, which are labeled with VIC®, FAM™ and NED™ dyes, respectively.  
|                             | • IPC template.                                                          | 3 tubes, 1.4 mL each | 2 to 8 °C (keep protected from exposure to light) |
| Quantifiler® Duo PCR Reaction Mix | • MgCl₂, dNTPs, bovine serum albumin, and AmpliTaq Gold® DNA Polymerase in buffer and salts.  
|                             | • Sodium azide (0.02% w/v) is incorporated as preservative.             | 1 Tube, 5.0 mL      | 2 to 8 °C (keep protected from exposure to light) |
| Quantifiler® Duo DNA Standard | Human male genomic DNA.                                                  | 1 tube, 120 µL      | 2 to 8 °C                                  |
| Quantifiler® Duo DNA Dilution Buffer | 10 mM Tris HCl buffer pH 8.0 containing 0.1 mM EDTA.                  | 2 Tubes, 1.8 mL each | 2 to 8 °C                                  |
Additional Storage Guideline For Primer Mix and PCR Reaction Mix

Keep Primer Mix and PCR Reaction Mix protected from direct exposure to light. Excessive exposure to light may affect the fluorescent probes and/or the passive reference dye.

Equipment and Materials Not Included

Tables 1-3 through 1-5 list required and optional equipment and materials not supplied with the Quantifiler® Duo DNA Quantification Kit. Unless otherwise noted, many of the items are available from major laboratory suppliers (MLS).

Table 1-3  Equipment not included

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applied Biosystems 7500 Real-Time PCR Instrument</td>
<td>Contact your local Applied Biosystems sales representative</td>
</tr>
<tr>
<td>tabletop centrifuge with 96-well plate adapters (optional)</td>
<td>MLS</td>
</tr>
</tbody>
</table>

Table 1-4  User-supplied materials

<table>
<thead>
<tr>
<th>Material</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantifiler® Duo DNA Quantification Kit</td>
<td>Applied Biosystems (PN 4387746)</td>
</tr>
<tr>
<td>High-Throughput Setup</td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Optical 96-Well Reaction Plate with Barcode</td>
<td>Applied Biosystems (PN 4306737)</td>
</tr>
<tr>
<td>MicroAmp® Optical Adhesive Film</td>
<td>Applied Biosystems (PN 4311971)</td>
</tr>
<tr>
<td>MicroAmp® Splash Free 96-Well Base</td>
<td>Applied Biosystems (PN 4312063)</td>
</tr>
</tbody>
</table>
Table 1-4  User-supplied materials (continued)

<table>
<thead>
<tr>
<th>Material</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-to-Low-Throughput Setup</td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Optical 8-Tube Strip (8 tubes/strip, 125 strips)</td>
<td>Applied Biosystems (PN 4316567)</td>
</tr>
<tr>
<td>MicroAmp® 96-Well Tray/Retainer Set</td>
<td>Applied Biosystems (PN 403081)</td>
</tr>
<tr>
<td>MicroAmp® Optical 8-Cap Strip (8 tubes/strip, 125 strips)</td>
<td>Applied Biosystems (PN 4323032)</td>
</tr>
</tbody>
</table>

Table 1-5  Documents

<table>
<thead>
<tr>
<th>Document</th>
<th>Applied Biosystems Part Number</th>
</tr>
</thead>
</table>
Chapter 2

Software Setup

Quantifiler® Duo DNA Quantification Kit User’s Manual
Software Setup

This chapter covers:
Overview ......................................................... 2-2
Starting the 7500 Real-Time PCR System ................... 2-3
About Plate Documents ......................................... 2-6
Setting Up a Plate Document ................................ 2-8
Setting Up a Plate Document Template .................... 2-26
## Overview

| **Purpose** | During software setup, you start up the 7500 Real-Time PCR System and set up a plate document for DNA quantification using the Quantifiler® Duo DNA Quantification Kit. |
| **Configuration** | The Quantifiler® Duo DNA Quantification Kit is supported using the 7500 Real-Time PCR System with SDS Software v1.2.3 for real-time data collection and analysis. |
Starting the 7500 Real-Time PCR System

Overview
Starting the 7500 Real-Time PCR System involves:
1. Starting the Computer (page 2-3)
2. Powering On the Instrument (page 2-3)
3. Starting the 7500 SDS Software (page 2-5)

Starting the Computer

1. If you are using the laptop computer, open it by pushing in the front, center button, holding it, and lifting up the lid.

2. Press the power button on the computer.

3. In the Enter User name field of the login window, type your name or the user name associated with the computer, if applicable.

4. If required, type your password in the Password field.

Powering On the Instrument

Note: Wait for the computer to finish starting up before powering on the 7500 instrument.

WARNING PHYSICAL INJURY HAZARD. Moving parts can crush and cut. Keep hands clear of moving parts while operating. Disconnect power before servicing the instrument.
Press the power button on the lower right front of the 7500 instrument.

- The indicator lights on the lower left of the front panel cycle through a power on sequence.
- When the green power indicator is lit (not flashing), communication is established between the computer and the instrument.

If the green power-on indicator is flashing or the red error indicator is lit, see the Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System Installation and Maintenance Guide (PN 4347828).
Starting the 7500 SDS Software

Select Start > 7500 System > 7500 System Software.

The first time you use the software, the Product Registration window displays and you are prompted to register the product.

Enter your name, organization, registration code, then click OK. On subsequent start ups, if the Product Registration window displays, click Cancel.

The software starts and displays the word “Disconnected” in the status bar on the bottom-right corner. The status changes to “Connected” only after the New Document Wizard is completed, the software is initialized, and the software is connected to the 7500 instrument. If the connection is successful, the software displays Connected in the status bar on the bottom-right corner.
About Plate Documents

How Plate Documents Are Used

Running a reaction plate on the 7500 system requires creating and setting up a plate document using the 7500 SDS software. A plate document is a representation of the arrangement of samples (standards and unknowns) and reagents on the reaction plate. The 7500 SDS software uses the plate document to:

- Coordinate the instrument operation, such as thermal cycling and data collection
- Organize and store the data gathered during the run
- Analyze the data from the run

Plate Document Types

You can use the SDS software to create two types of plate document files.

Table 2-1 Plate Documents

<table>
<thead>
<tr>
<th>Plate Document Type</th>
<th>File Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDS document</td>
<td>*.sds</td>
<td>Primary file to use when performing a run. Required for all experiments.</td>
</tr>
<tr>
<td>SDS template</td>
<td>*.sdt</td>
<td>File that already contains run parameters that are commonly used in plate documents, such as detectors, thermal cycler conditions, and so on. Streamlines the creation of the SDS document (*.sds) file.</td>
</tr>
</tbody>
</table>
Example Plate Document Setup

You can arrange the reactions in any well of the reaction plate, but set up the plate document so that it corresponds exactly to the arrangement of the standards and unknown samples in the wells of the reaction plate.

Table 2-2 shows one example of arranging reactions.

Note: For each Quantifiler® Duo DNA Quantification Kit assay, there are eight DNA quantification standards and two reactions for each standard. See “Preparing the DNA Quantification Standards” on page 3-2 for more information about the DNA quantification standards.

Table 2-2  Example plate setup of reactions (UNKN=unknown, NTC=non-template control)

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Std 1</td>
<td>Std 1</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>B</td>
<td>Std 2</td>
<td>Std 2</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>C</td>
<td>Std 3</td>
<td>Std 3</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>D</td>
<td>Std 4</td>
<td>Std 4</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>E</td>
<td>Std 5</td>
<td>Std 5</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>F</td>
<td>Std 6</td>
<td>Std 6</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>G</td>
<td>Std 7</td>
<td>Std 7</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
</tr>
<tr>
<td>H</td>
<td>Std 8</td>
<td>Std 8</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>UNKN</td>
<td>NTC</td>
</tr>
</tbody>
</table>
Setting Up a Plate Document

**Overview**

Setting up a plate document to run the Quantifiler® Duo DNA Quantification Kit assay involves:

1. **Creating a Blank Plate Document** (page 2-9)
2. **Creating Detectors** (page 2-10)
3. **Adding Detectors to the Plate Document** (page 2-15)
4. **Adding Detectors to an Open Plate Document (Alternative)** (page 2-19)
5. **Assigning Sample Name, Task, and Quantity to Standards** (page 2-20)
6. **Assigning Sample Name and Task to Unknown Samples and Non-Template Controls** (page 2-22)
7. **Setting Thermal Cycler Conditions** (page 2-24)
8. **Saving the Plate Document and Starting the Run** (page 2-25)
Creating a Blank Plate Document

To create a blank plate document:

1. If the 7500 SDS software is not already started, select Start > Programs > 7500 System > 7500 System Software. You can also launch the software from the shortcut on your desktop by double-clicking the icon.

2. In the 7500 SDS software, select File > New to open the New Document Wizard - Define Document window. The default settings are shown.
Creating Detectors

The first time you run the Quantifiler® Duo DNA Quantification Kit assay you must create three detectors in the 7500 SDS Software.

There are two methods for creating these detectors.

- You can create the detectors upon first run from the New Document Wizard Select Detector Window,

  or

- You can create the detectors from an open plate document.

Both methods are explained below.

After you create these detectors, you do not need to create any others for subsequent runs of the Quantifiler® Duo DNA Quantification Kit assays. Upon completion, proceed to “Adding Detectors to the Plate Document” on page 2-15.
To create detectors:

1. Open the New Detector dialog box:
   - From the Document Wizard - Select Detectors window, click **New Detector** to open the New Detector dialog box.
   - or
   - From an open plate document, select **Tools > Detector Manager** to open the Detector Manager.

   ![Detector Manager dialog box](image)

   • Then, in the Detector Manager window, select **File > New** to open the New Detector dialog box.
To create detectors: (continued)

2. In the New Detector dialog box, create a detector for the RPPH1 human target:
   a. Enter **Duo Human** in the name field.
   b. Select **VIC** for the Reporter Dye.
   c. Select *(none)* for the Quencher Dye.
   d. Click and select a color.

**IMPORTANT!** Make sure that you select the VIC dye for Duo Human.

3. Click **Create Another** to add Duo Human to the Detector Name list, and to reset the New Detector dialog box.
To create detectors: (continued)

4. Create a detector for the SRY Male target:
   a. Enter **Duo Male** in the name field.
   b. Select **FAM** for the Reporter Dye.
   c. Select **(none)** for the Quencher Dye.
   d. Click and select a color.

   **IMPORTANT!** Make sure that you select the FAM dye for Duo Male.

5. Click **Create Another** to add Duo Male to the Detector Name list, and to reset the New Detector dialog box.
6. Create a detector for the IPC target:
   a. Enter **Duo IPC** in the name field.
   b. Select **NED** for the Reporter Dye.
   c. Select **(none)** for the Quencher Dye.
   d. Click and select a color.

**IMPORTANT!** Make sure that you select the NED dye for Duo IPC.

To create detectors: (continued)
To create detectors: (continued)

7. Click **OK** to add Duo IPC to the Detector Name list, and to return to the Select Detectors window.

![New Document Wizard](image)

When you are finished, add detectors to the plate document.

**IMPORTANT!** Make sure that the appropriate reporter dye is selected for the three detectors: VIC® for Duo Human, FAM™ for Duo Male and NED™ for Duo IPC.

### Adding Detectors to the Plate Document

There are two methods for adding detectors:

- You can add the detectors from the New Document Wizard - Select Detector Window,

  or

- You can add the detectors from an open plate document.

Both methods are explained below.
To add detectors to the plate document:

1. In the New Document Wizard - Select Detectors window, Ctrl-click the **Duo Human, Duo Male** and **Duo IPC** detectors. If the detectors for the Duo DNA Quantification Kit are not listed in the Detector Name field, see the Creating Detectors section (page 2-10).

2. Select **ROX** as the Passive Reference and click **Add** to add the detectors to the Detectors in Document list.

3. Click **Next** to continue to the Set Up Sample Plate window.
4. In the Set Up Sample Plate window, select wells and detectors to apply:
   - Ctrl-click all wells containing quantification standards, unknown samples and Non-Template Control (shown in color).
   - Check all three detectors listed in the Use column (Duo Human, Duo Male and Duo IPC)

**IMPORTANT!** Apply all three detectors to the plate document for all the wells that contain Quantifier® Duo DNA Quantification Kit assay reagents.

5. Click **Finish** in the New Document Wizard - Set Up Sample Plate window to complete the New Document Wizard and to be automatically directed to the Plate Setup tab.

The 7500 System Software initializes and connects to the 7500 instrument. If the connection is successful, displays in the bottom-right corner status bar.
When you are finished, in the 7500 System Software Plate - Setup tab (Figure 2-1) assign sample names, tasks, and quantities to standards as necessary (see page 2-20 for procedure).

Figure 2-1  7500 System Software Plate - Setup tab
To alternatively add detectors to an open plate document:

1. Within an open plate document, select **Tools > Detector Manager** to open the Detector Manager window.

2. In the Detector Manager window, Ctrl-click the **Duo Human**, **Duo Male** and **Duo IPC** detectors, then click **Add to plate Document**.

   If the detectors for the Duo DNA Quantification Kit are not listed in the Detector Name field, see “Creating Detectors” on page 2-10.

3. Click **Done** to close the Detector Manager.

When you are finished, in the 7500 System Software Plate - Setup tab (shown previously in Figure 2-1) assign sample names, tasks, and quantities to standards as necessary (see page 2-20 for procedure).
Assigning Sample Name, Task, and Quantity to Standards

**IMPORTANT!** Assign Sample Name, Task and Quantity parameters for each quantity separately. For example, assign the parameters for quantification standard 1, and then for quantification standard 2, and so on, until you finish assigning the parameters for all wells containing quantification standards.

To apply parameters to quantification standards:

1. In the Plate Setup tab, select wells that correspond to a specific quantification standard for the Duo DNA Quantification Kit (e.g. Std. 1).

2. With the wells selected, click **View > Well Inspector** (or Ctrl-double click the wells) to open the Well Inspector dialog box.

**Note:** The Well Inspector displays the detectors that were added to the plate document.
To apply parameters to quantification standards: *(continued)*

3. Complete the fields in the Well Inspector dialog box:
   a. For the Duo Human and Duo Male detectors, click Unknown in the Task column, then select Standard from the drop-down list.
   b. For the Duo Human and Duo Male detectors, select the Quantity field and enter the appropriate quantity of DNA in the well expressed in ng/µL for both detectors (e.g. enter 50 for Std. 1 for both Duo Human and Duo Male detectors).
   c. Enter the Sample Name (e.g. Std. 1, Std. 2, and so on).
   d. For the Duo IPC detector, keep the default Task as Unknown.

   **Note:** Make sure that ROX is selected as Passive Reference.

4. Click **Close** to close the dialog box.

When you are finished, assign sample names, tasks, and quantities to unknown samples and non-template controls, as necessary.
Assigning Sample Name and Task to Unknown Samples and Non-Template Controls

To assign parameters to unknown samples and non-template control (NTC) wells:

1. In the Plate Setup tab, select the wells that correspond to an unknown sample or NTC for the Duo DNA Quantification Kit.

2. With the well(s) selected, select View > Well Inspector (or Ctrl-double click) to open the Well Inspector dialog box. The Well Inspector displays the detectors that were added to the plate document.
To assign parameters to unknown samples and non-template control (NTC) wells: (continued)

3. Enter the parameters:
   a. In the Task column, keep the default “Unknown” for all three detectors.
   b. Enter the Sample Name (for example, Unknown 1 for unknown samples and NTC for NTC wells).

**Note:** For the Passive Reference, select ROX.

**Example:** Unknown samples.

![Well Inspector](image1)

**Example:** NTC Wells.

![Well Inspector](image2)

**Note:** Samples with identical sample names are treated as replicates by the 7500 System Software. Results for replicate reactions are grouped together automatically for data analysis.

4. Click **Close** to close the Well Inspector window.
When you are finished assigning all parameters, set the thermal cycler conditions, as described in the following section.

**Setting Thermal Cycler Conditions**

Before running a Duo DNA Quantification Kit assay, set the thermal cycler conditions by changing the default thermal cycler Sample Volume.

**To set thermal cycler conditions:**

1. In the plate document, select the **Instrument** tab.

2. Change the Sample Volume to **25** (µL) and select the 9600 Emulation box.

   **Note:** Selecting the 9600 Emulation box reduces the ramp rate.

   **Note:** The thermal cycler protocol validated for use with the Quantifiler® Duo kit includes a hold step at 50 °C for 2 minutes. This step was deleted from the *Quantifiler® Human* and *Quantifiler® Y Human Male Kit Thermal Cycler Protocol*.
When you are finished, save the plate document and start the run, as described in the following section.

### Saving the Plate Document and Starting the Run

Before running the reaction plate, save the plate document as an SDS Document (*.sds) file.

**Note:** To save the plate document as a template, see “Setting Up a Plate Document Template” on page 2-26.

To save the plate document and start the run:

1. Select **File > Save**.
2. Select the location for the plate document.
3. Enter a file name.
4. For Save as type, select **SDS Documents (*.sds)**.
5. Click **Save**, then **Start** to start the run.
Chapter 2  Software Setup

Setting Up a Plate Document Template

Purpose  A plate document template reduces the time required to set up a plate document. This section describes how to create an SDS Template Document (*.sdt) for running the Quantifiler® Duo DNA Quantification Kit assays.

Template Settings  In addition to plate document settings (assay and container), templates can contain:

- Assay-specific detectors
- Well assignments for quantification standards, with detectors, tasks, and quantity
- Well assignments for unknown samples, with detectors and tasks
- Instrument settings: reaction volume settings and 9600 Emulation setting

Creating a Plate Document Template  This procedure assumes that you have created the detectors for running reactions using the Duo DNA Quantification Kit (page 2-10).

To create a plate document template:

1. If the 7500 SDS Software is not already started, select Start > Programs > 7500 System > 7500 System Software.

2. Select File > New to open the New Document Wizard - Define Document window, then click Next.
To create a plate document template: *(continued)*

3. Apply the applicable template settings to the plate document:
   - Add detectors to the plate document *(page 2-15).*
   - Apply detectors and assign sample name, task, and quantity to standards, unknown samples, and NTC wells *(page 2-20 and page 2-22).*
   - Set thermal cycler conditions *(page 2-24).*

4. Select **File > Save As** and complete the Save As dialog box:
   a. For Save as type, select **SDS Templates (*.sdt).**
   b. Locate and select the Templates folder within the software folder:
      \[X:\text{Program Files > 7500 System > Templates}\], where \(X\) is the hard drive on which the 7500 System SDS software is installed.
      
      **Note:** Saving the template file in the Templates folder makes the template available in the Template drop-down list of the New Document Wizard - Define Document window *(see step 2 in “Creating a Plate Document from a Template” on page 2-28).*
   c. For File name, enter a name for the template. For example, enter **Duo Template**:
   d. Click **Save.**
Creating a Plate Document from a Template

After you create a template, you can use it to create a plate document.

To create a plate document from a template:

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>If the SDS software is not already started, select <strong>Start &gt; Programs &gt; 7500 System &gt; 7500 System Software.</strong></td>
</tr>
</tbody>
</table>
| 2.   | Select **File > New** to open the New Document Wizard - Define Document window and make the following selections:  
  - For Assay, select **Absolute Quantitation.**  
  - For Container, select **96-Well Clear.**  
  - For Template, select an applicable template from the list.  
  *Note:* If the template is not available in the list, click **Browse** to locate and select an applicable template. |
| 3.   | Click **Finish** and go to the Plate Setup tab. |
| 4.   | If the template doesn't contain all the information you need, complete the plate document as follows:  
  - Add detectors to the plate document using the open plate alternative method *(page 2-19)*  
  - Apply detectors and assign sample name, task, and quantity to standards, unknown samples, and NTC wells *(page 2-20 and page 2-22)*  
  - Set thermal cycler conditions *(page 2-24)*  
  *Note:* The tasks that you perform at this stage vary according to which settings were defined in the template. |
| 5.   | Save the plate document *(page 2-25).*  
  *Note:* For Save as type, select **SDS Documents (*.sds).** |
Chapter 3

PCR Amplification
This chapter covers:
Preparation of DNA Quantification Standards ..................3-2
Preparation of Reactions .......................................3-5
Running the Reactions .........................................3-7
## Preparing the DNA Quantification Standards

### Required Materials

The required materials include:

- Pipettors
- Pipette tips
- Microfuge tubes
- Quantifiler® Duo DNA Standard
- Quantifiler® Duo DNA Dilution Buffer

**Note:** You can store the diluted DNA quantification standards for up to 2 weeks at 2 to 8 °C. Longer term storage is not recommended.

### Guidelines for Calculating the Standards Dilution Series

The standard dilution series example shown in Table 3-1 on page 3-3 is suitable for general use.

**IMPORTANT!** Applied Biosystems recommends:

- Three-fold dilution series with eight concentration points in the standard series
- Minimum input volume of 10 µL DNA for dilutions (to ensure accuracy of pipetting)
Preparing the DNA Quantification Standards

Standards Dilution Series Example

Table 3-1 shows an example of one standards dilution series with the concentrations ranging from 50 ng/µL (Std. 1) to 0.023 ng/µL, or 23 pg/µL (Std. 8). When 2.0 µL of a sample at the lowest concentration (23 pg/µL) is loaded in a reaction, the well contains approximately 7 diploid human genome equivalents. These equivalents correspond to approximately 14 copies of the Duo Human target locus and approximately 7 copies of the Duo Male target locus (Y chromosome loci are haploid).

Table 3-1 Standards dilution series example

<table>
<thead>
<tr>
<th>Standard</th>
<th>Concentration (ng/µL)</th>
<th>Example Amounts</th>
<th>Minimum Amounts</th>
<th>Dilution Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Std. 1</td>
<td>50.000</td>
<td>50 µL [200 ng/µL stock] + 150 µL Quantifiler® Duo DNA dilution buffer</td>
<td>10 µL [200 ng/µL stock] + 30 µL Quantifiler® Duo DNA dilution buffer</td>
<td>4X</td>
</tr>
<tr>
<td>Std. 2</td>
<td>16.700</td>
<td>50 µL [Std. 1] + 100 µL Quantifiler® Duo DNA dilution buffer</td>
<td>10 µL [Std. 1] + 20 µL Quantifiler® Duo DNA dilution buffer</td>
<td>3X</td>
</tr>
<tr>
<td>Std. 3</td>
<td>5.560</td>
<td>50 µL [Std. 2] + 100 µL Quantifiler® Duo DNA dilution buffer</td>
<td>10 µL [Std. 2] + 20 µL Quantifiler® Duo DNA dilution buffer</td>
<td>3X</td>
</tr>
<tr>
<td>Std. 4</td>
<td>1.850</td>
<td>50 µL [Std. 3] + 100 µL Quantifiler® Duo DNA dilution buffer</td>
<td>10 µL [Std. 3] + 20 µL Quantifiler® Duo DNA dilution buffer</td>
<td>3X</td>
</tr>
<tr>
<td>Std. 5</td>
<td>0.620</td>
<td>50 µL [Std. 4] + 100 µL Quantifiler® Duo DNA dilution buffer</td>
<td>10 µL [Std. 4] + 20 µL Quantifiler® Duo DNA dilution buffer</td>
<td>3X</td>
</tr>
<tr>
<td>Std. 6</td>
<td>0.210</td>
<td>50 µL [Std. 5] + 100 µL Quantifiler® Duo DNA dilution buffer</td>
<td>10 µL [Std. 5] + 20 µL Quantifiler® Duo DNA dilution buffer</td>
<td>3X</td>
</tr>
<tr>
<td>Std. 7</td>
<td>0.068</td>
<td>50 µL [Std. 6] + 100 µL Quantifiler® Duo DNA dilution buffer</td>
<td>10 µL [Std. 6] + 20 µL Quantifiler® Duo DNA dilution buffer</td>
<td>3X</td>
</tr>
<tr>
<td>Std. 8</td>
<td>0.023</td>
<td>50 µL [Std. 7] + 100 µL Quantifiler® Duo DNA dilution buffer</td>
<td>10 µL [Std. 7] + 20 µL Quantifiler® Duo DNA dilution buffer</td>
<td>3X</td>
</tr>
</tbody>
</table>
While preparing the standards, keep in mind that:

- DNA quantification standards are critical for accurate analysis of run data
- Mistakes or inaccuracies in making the dilutions directly affect the quality of results
- The quality of pipettors and tips and the care used in measuring and mixing dilutions affect accuracy

When using Quantifiler® Duo DNA Dilution Buffer, you can store the prepared DNA quantification standards for up to 2 weeks at 2 to 8 °C.

To prepare the DNA quantification standards dilution series:

1. Label eight microcentrifuge tubes: Std. 1, Std. 2, Std. 3, and so on.

2. Dispense the required amount of diluent (Quantifiler® Duo DNA Dilution Buffer) to each tube (refer to Table 3-1 for volumes).

3. Prepare Std. 1:
   a. Vortex the Quantifiler® Duo DNA Standard 3 to 5 seconds.
   b. Using a new pipette tip, add the calculated amount of Quantifiler® Duo DNA Standard to the tube for Std. 1.
   c. Mix the dilution thoroughly.

4. Prepare Std. 2 through 8:
   a. Using a new pipette tip, add the calculated amount of the prepared standard to the tube for the next standard (refer to Table 3-1 for volumes).
   b. Mix the standard thoroughly.
   c. Repeat steps 4a and 4b until you complete the dilution series.
Preparing the Reactions

Required Materials

- Quantifiler® Duo Primer Mix
- Quantifiler® Duo PCR Reaction Mix
- 10-mL polypropylene tube
- 96-well reaction plate
- Extracted DNA samples
- DNA quantification standards dilutions series
- Optical adhesive cover

Preparing the Reactions

While preparing the reactions, keep the 96-well reaction plate in its base and do not place it directly on the bench top to protect it from scratches and particulate matter.

To prepare the reactions:

1. Calculate the volume of each component needed to prepare the reactions, using the table below.

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume Per Reaction (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantifiler® Duo Primer Mix</td>
<td>10.5</td>
</tr>
<tr>
<td>Quantifiler® Duo PCR Reaction Mix</td>
<td>12.5</td>
</tr>
</tbody>
</table>

Note: Include additional reactions in your calculations to provide excess volume for the loss that occurs during reagent transfers.

⚠️ CAUTION CHEMICAL HAZARD. Quantifiler® Duo PCR Reaction Mix may cause eye and skin irritation. Exposure may cause discomfort if swallowed or inhaled. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.
### To prepare the reactions: (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
</tr>
</thead>
</table>
| 2.   | Prepare the reagents:  
      | - Thaw the Quantifiler® Duo Primer Mix completely, then vortex 3 to 5 seconds and centrifuge briefly before opening the tube.  
      | - Swirl the Quantifiler® Duo PCR Reaction Mix gently before using. Do not vortex it. |
| 3.   | Pipette the required volumes of components into an appropriately sized polypropylene tube. |
| 4.   | Vortex the PCR mix 3 to 5 seconds, then centrifuge briefly. |
| 5.   | Dispense 23 µL of the PCR mix into each reaction well. |
| 6.   | Add 2 µL of sample, standard, or control to the applicable wells. For a plate setup example, see page 2-7.  
      | **IMPORTANT!** Applied Biosystems recommends running duplicates of the eight DNA quantification standards for each reaction plate. |
| 7.   | Seal the reaction plate with the Optical Adhesive Cover. |
| 8.   | Centrifuge the plate at 3000 rpm for about 20 seconds in a tabletop centrifuge with plate holders to remove any bubbles.  
      | **Note:** If a tabletop centrifuge with 96-well plate adapters is not available, visually inspect the plate for bubbles, and lightly tap the plate to remove bubbles in wells. |
Running the Reactions

Before You Run the Reactions

Before you run the reactions, make sure that you have:

- Powered on the 7500 Real-Time PCR instrument, computer, and software. For setup procedures, see page 2-3.
- Set up a plate document for the run. See page 2-7.

Running the Plate on the 7500 Real-Time PCR Instrument

To run the plate on the 7500 Real-Time PCR instrument:

1. Press the tray door to open it.

2. Load the plate into the plate holder in the instrument. Ensure that the plate is correctly aligned in the holder.
### Chapter 3  PCR Amplification

To run the plate on the 7500 Real-Time PCR instrument: *(continued)*

<table>
<thead>
<tr>
<th>3.</th>
<th>Load standard 96-well plates with the notched A12 position at the top-right of the tray.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>![Diagram of the 7500 Real-Time PCR instrument showing Well A1]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4.</th>
<th>Close the tray door.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>![Diagram of the tray door being closed]</td>
</tr>
</tbody>
</table>
To run the plate on the 7500 Real-Time PCR instrument: (continued)

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>5.</strong></td>
<td>Apply pressure to the right side of the tray and at an angle to close the tray door.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Image of tray being closed" /></td>
</tr>
<tr>
<td></td>
<td>Press forward here at slight right angle.</td>
</tr>
<tr>
<td><strong>6.</strong></td>
<td>In the 7500 SDS software, open the plate document that you set up for the run.</td>
</tr>
<tr>
<td><strong>7.</strong></td>
<td>Select the Instrument tab, then click <strong>Start</strong>.</td>
</tr>
</tbody>
</table>
Chapter 4

Data Analysis and Results
Data Analysis and Results

This chapter covers:

Analyzing the Plate Document .............................................4-2
Viewing Results. ...............................................................4-4
Analyzing the Plate Document

Analyze a run after it is complete and reanalyze after you make any changes to the plate document, such as sample names.

To analyze a plate document:

1. To open the plate document for analysis:
   - Navigate to the folder where the run file is stored, and double-click the run file.
   - or
   - Launch the software from the shortcut on your desktop:
     - Double-click the 7500 System Software icon,
     - Click File > Open,
     - Then select the run file and click Open (or double-click the run file).
To analyze a plate document: (continued)

2. Verify the analysis settings:
   a. On the menu bar, select **Analysis > Analysis Settings**
      to open the Analysis Settings dialog box.
   b. Verify that the settings are as shown below, then click **OK**.

   ![Analysis Settings](image)

   **IMPORTANT!** If the analysis settings differ from those shown here, change them to match the settings, then click **OK**.

3. On the menu bar, select **Analysis > Analyze**.

   **Note:** For routine analysis that doesn't require any change in the Analysis Settings and to skip all the steps described above, click the green arrow on the system software tool bar.
Chapter 4  Data Analysis and Results

Viewing Results

Overview

Viewing the results of data analysis can involve one or more of the following:

- Viewing the Standard Curve (page 4-4)
- Viewing the Amplification Plot (page 4-6)
- Viewing the Report (page 4-6)
- Exporting the Results (page 4-8)

Viewing the Standard Curve

For information about interpreting and troubleshooting the standard curve, see “Examining the Standard Curve” on page 5-3 and “Troubleshooting the Standard Curve” on page 5-5.

To view the standard curve:

1. In the Results tab, select the Standard Curve tab.

2. In the Detector drop-down list, select the applicable detector:
   - Duo Human or
   - Duo Male

3. View the C_T values for the quantification standard reactions and the calculated regression line, slope, y-intercept, and R^2 values.
Viewing Results

To view the standard curve: (continued)

4. In the Detector drop-down list, select ALL to view both standard curves at the same time. Only $C_T$ values can be viewed with this selection.

**Note:** The figure below shows an example of the standard curve plots. The gap between the Duo Human and the Duo Male $C_T$ values may vary depending on the relative slopes of the two targets and instrument performance.

**Amplification Plot Results**

The amplification plot can display one of the following:

- Plot of normalized reporter signal ($R_n$) versus cycle (log) view
- $C_T$ versus well position view
- Plot of normalized reporter signal ($R_n$) versus cycle (linear view)

For more information about the amplification plot, see “Real-Time Data Analysis” on page 1-9 or the Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System Absolute Quantification Getting Started Guide (PN 4378658).
Chapter 4  Data Analysis and Results

Viewing the Amplification Plot

For troubleshooting information, see “Troubleshooting Amplification Plots” on page 5-15.

To view the amplification plot:

1. In the Results tab, select the Amplification Plot tab.

2. In the Detector drop-down list, select a detector:
   - Duo Human
   - Duo Male
   - IPC

3. Select the applicable samples in the table below the amplification plot.

4. Make sure that the Threshold is set to 0.20, the default setting.
   Note: If you move the threshold bar, it changes from green to red to indicate that reanalysis is needed. After reanalysis, it changes from red back to green.

Viewing the Report

The report displays data for selected wells in tabular form and summarizes the quantity of DNA present in the samples. For information about the quantities reported, see “Assessing Quantity” on page 5-19.

To view the report:

1. In the analyzed plate document, select the Results tab, then select the Report tab.

2. Select the reactions in the 96-well plate representation below the report to display the results in the report.
To view the report: *(continued)*

3. View the Qty column to determine the quantity of DNA in each sample.

**Note:** The values in the Qty column are calculated by interpolation from the standard curve for a given sample. Quantities are calculated only if quantification standards were run and set up correctly in the software. Otherwise, only C_T values are shown.

**Note:** Go to **Tools > Report Settings** to format the report for printing. Refer to the Online Help for more information about the Report Settings dialog box.

![Report Settings dialog box](image)
Exporting the Results

You can export numeric data into text files, which can then be imported into spreadsheet applications such as Microsoft Excel®.

To export the results:

1. In the analyzed plate document, select **File > Export**, then select the data type to export:
   - Sample Setup (*.txt)
   - Calibration Data (*.csv)
   - Spectra (*.csv)
   - Component (*.csv)
   - Delta Rn (*.csv)
   - C_T (*.csv)
   - Dissociation (*.csv)
   - Results

2. Enter a file name for the export file and click **Save**.

For more information about exporting data, see the Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System Absolute Quantification Getting Started Guide (PN 4378658).
Chapter 5

Interpretation of Results
Interpretation of Results

This chapter covers:

- Checking Analysis Settings .................................................. 5-2
- Examining the Standard Curve ............................................ 5-3
- Troubleshooting the Standard Curve ................................... 5-5
- Using the Internal PCR Control System ............................. 5-13
- Troubleshooting Amplification Plots .................................. 5-15
- Assessing Quantity ............................................................. 5-19
- Calculating Male : Female DNA Ratio .............................. 5-20
- Improving Assay Performance .......................................... 5-20
  - Assessing Sensitivity and Results ................................. 5-20
  - Assessing and Troubleshooting False Positive Results .... 5-22
  - Preventing PCR Contamination ................................... 5-23
Checking Analysis Settings

The validity of the results requires correct analysis settings.

To check analysis settings on the 7500 SDS:

1. If the SDS software is not already started, select **Start > Programs > 7500 System > 7500 System Software**.

2. Select **File > Open**.

3. Locate the plate document for the assay run of interest, select it, then click **Open**. Alternatively, navigate to the folder containing the run file and double-click the run file to skip the previous steps.

4. Select **Analysis > Analysis Settings**.

5. For all detectors, confirm that the settings are set as shown:
   - Select **All Detectors**.
   - Select **Manual Ct** and enter **0.2** as the Threshold.
   - Select **Manual Baseline** and enter 3 to 15 as cycle range.

If the analysis settings differ from those shown, set as noted above and click **Apply**, then click **OK & Reanalyze** to reanalyze and close the plate document. View the results using **Chapter 4, “Data Analysis and Results.”**
Examining the Standard Curve

Examine the standard curve results to evaluate the quality of the results from the quantification standard reactions.

About Standard Curve Results

The standard curve is a graph of the $C_T$ of quantification standard reactions plotted against the starting quantity of the standards. The software calculates the regression line by calculating the best fit with the quantification standard data points. The regression line formula has the form:

$$ C_T = m \left[ \log (Qty) \right] + b $$

where $m$ is the slope, $b$ is the $y$-intercept, and $Qty$ is the starting DNA quantity. The values associated with the regression analysis can be interpreted as follows:

- **$R^2$ value** – Measure of the closeness of fit between the standard curve regression line and the individual $C_T$ data points of quantification standard reactions. A value of 1.00 indicates a perfect fit between the regression line and the data points.
- **Regression coefficients**:
  - **Slope** – Indicates the PCR amplification efficiency for the assay. A slope of $-3.3$ indicates 100% amplification efficiency.
  - **Y-intercept** – Indicates the expected $C_T$ value for a sample with $Qty = 1$ (for example, 1 ng/µL).

**$R^2$ Value**

An $R^2$ value $\geq 0.99$ indicates a close fit between the standard curve regression line and the individual $C_T$ data points of quantification standard reactions.

If the $R^2$ value is $<0.98$ check the following:

- Quantity values entered for quantification standards in the Well Inspector during plate document setup.
- Making of serial dilutions of quantification standards.
- Loading of reactions for quantification standards.
- Failure of reactions containing quantification standards.
- $C_T$ value for Standard 8 of the DNA quantification standard (23 pg/µL) particularly for the male-specific standard curve.
**R² Value < 0.98**

If the \( R^2 \) value is <0.98, you may choose to omit Std. 8 of the DNA quantification standard (23 pg/µL) from analysis. The Quantifiler® Duo DNA Quantification Kit assay can quantify 23 pg/µL of human genomic DNA in a sample. When 2.0 µL of a sample at this concentration is loaded in a reaction, the well contains approximately 7 diploid human genome equivalents. These equivalents correspond to approximately 14 copies of the Duo Human target locus and approximately 7 copies of the Duo Male target locus (Y chromosome loci are haploid). Because of stochastic effects when using the lowest concentration point, the \( C_T \) values are more variable and may affect the closeness of fit between the standard curve regression line and the individual data points of the quantification.

**To omit Standard 8 from analysis:**

1. Select the wells in the plate document that correspond to Standard 8 and open the Well Inspector.
2. Change the Task assignment for the applicable detector from Standard to Unknown.
3. Reanalyze the plate to incorporate the change.

**Slope**

A slope close to \(-3.3\) indicates optimal, 100% PCR amplification efficiency.

**Table 5-1  Range and average of standard-curve slope values**

<table>
<thead>
<tr>
<th>Kit</th>
<th>Typical Slope (range)</th>
<th>Average Slope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantifiler® Duo</td>
<td>−3.0 to −3.6</td>
<td>−3.3</td>
</tr>
</tbody>
</table>

The slope values listed in Table 5-1 represent the typical range of slope values observed during the development and validation of the Quantifiler® Duo kit. Some deviations from this range may be observed due to instrument performance. If the slope varies beyond the typical range indicated in Table 5-1, check the following:

- Assay setup
- Software setup
- Reagents
- Instrument
Troubleshooting the Standard Curve

The following table and corresponding sections provide examples of errors that can result by applying incorrect detectors to standards during setup of the plate document. For instructions on how to apply detectors for standards correctly, see “Creating Detectors” on page 2-10. The standard curves shown in the following examples represent plots that result from incorrect detector setup and should not be used.

Table 5-2 Troubleshooting the standard curve

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slope for the standard curve is outside the typical range or [R^2] value is significantly less than 0.98</td>
<td>The PCR reaction exhibits stochastic effects at the lowest concentration point.</td>
<td>Omit Standard 8 of the DNA quantification standard (23 pg/µL) from analysis (see the procedure “To omit Standard 8 from analysis:” on page 5-4).</td>
</tr>
</tbody>
</table>
| When applying detectors for standards, the Task and Quantity were applied to the wrong detector (see “Example 1” on page 5-6). | 1. From the plate document, double-click a well containing a DNA quantification standard to view the Well Inspector.  
2. Verify that the Task and Quantity were applied to the correct detector and reanalyze. |                                                                                     |
| When applying detectors for the standards, the incorrect Quantity was entered (see “Example 2” on page 5-9). | 1. From the plate document, double-click a well containing a DNA quantification standard to view the Well Inspector.  
2. Verify that the correct Quantity was entered and reanalyze. |                                                                                     |
The following examples illustrate the observations referenced in the table above.

Example 1  Observation

All of the \(C_T\) values for the DNA quantification standard reactions for the Duo Human detector lie outside of the standard curve and form a horizontal line when All detectors are selected in the Standard Curve tab (Figure 5-1). Note that the affected detector disappears from the detector list and Duo IPC appears instead, as shown in the pull-down menu in Figure 5-2. As a result, the slope for the Duo Human standard curve was outside the typical range and the \(R^2\) value is significantly less than 0.98.
Legend: The Standard Task and Quantity were applied to the Duo IPC detector instead of the Duo Human detector, resulting in an incorrect representation of the Duo Human standard curve as a horizontal line.

Figure 5-1  Example 1
Chapter 5  Interpretation of Results

5-8 Quantifier® Duo DNA Quantification Kit User’s Manual

Figure 5-2  Example 1

Possible Cause

When applying detectors for the standards, the Task and Quantity were applied to the Duo IPC detector instead of the Duo Human detector, as shown in Figure 5-3 below.

Legend:  The Standard Task and Quantity were applied to the Duo IPC detector instead of the Duo Human detector, resulting in an incorrect representation of the Duo Human standard curve AND only the Duo IPC Detector is displayed in the drop-down list.  Note the adjustment of the Y-axis scale based on Detector selection.

Figure 5-3  Example 1: Possible Cause
Example 2  Observation

One point for one detector (either Duo Human or Duo Male) lies outside of the standard curve. In Figure 5-4 below, Duo Human is the affected detector.

Legend: One point lies outside the Duo Human standard curve.

Figure 5-4  Example 2

Possible Cause

When applying detectors for the standards, the incorrect Quantity was entered. As noted in Figure 5-5 below, 0.062 was entered for the Quantity instead of 0.62.
### Example 3 Observation

At each concentration, only one standard curve is shown (either for the Duo Human or for the Duo Male detector) and only one detector (either Duo Human or Duo Male) is available in the Standard Curve tab. In Figure 5-6 below, Duo Human is the only detector available.

Legend: Only the Duo Human curve is available for display in the Standard Curve plot.
Possible Cause

When applying detectors for the standards, Duo Male was not selected, as shown in Figure 5-7 below.

![Well Inspector](image)

Detector not applied

**Figure 5-7  Example 3: Possible Cause**

**Example 4  Observation**

At each concentration, the $C_T$ values for the Duo Human detector are higher than the $C_T$ values for the Duo Male detector. As shown in Figure 5-8 below, the whole standard curve for the Duo-Human detector lies on the right side of the Duo-Male standard curve when *All* Detectors are selected in the Standard Curve tab. The gap between the Duo Human and the Duo Male $C_T$ values may vary depending on the relative slopes of the two targets and instrument performance.
Figure 5-8  Example 4: Observation

Possible Cause

When creating detectors for the standards as shown in Figure 5-9 below, **FAM** was selected as the reporter dye for Duo Human and **VIC** was selected as the reporter dye for Duo Male instead of the opposite.

Legend: The Duo Human and Duo Male standard curves are exchanged.

Figure 5-9  Example 4: Possible Cause
Using the Internal PCR Control System

**Purpose**

Use the Internal PCR Control (IPC) system to distinguish between true negative sample results and reactions affected by:

- The presence of PCR inhibitors
- Assay setup
- A chemistry or instrument failure

**Components**

The following components of the IPC system are present in the Quantifiler® Duo Primer mix:

- Synthetic DNA template
- Primers that hybridize specifically to the synthetic DNA template
- Probe labeled with NED™ dye

**Interpreting IPC Results**

In the amplification plot window of the SDS software, observe amplification of the VIC® and FAM™ dyes (Duo Human detector and Duo Male detector) and the NED™ dye (Duo IPC detector), then use Table 5-3 to interpret the IPC results.

<table>
<thead>
<tr>
<th>Duo Human (VIC® dye) and/or Duo Male (FAM™ Dye)</th>
<th>Duo IPC (NED™ Dye)</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>No amplification</td>
<td>Amplification</td>
<td>Negative result - no human DNA detected</td>
</tr>
<tr>
<td>No amplification</td>
<td>No amplification</td>
<td>Invalid result</td>
</tr>
<tr>
<td>Amplification (low C_T and high ΔR_n)</td>
<td>No amplification or C_T higher than 31</td>
<td>IPC result inconclusive</td>
</tr>
<tr>
<td>Amplification (high C_T and low ΔR_n)</td>
<td>No amplification or C_T higher than 31</td>
<td>PCR inhibition</td>
</tr>
</tbody>
</table>

**Note:** Positive amplification occurs when the C_T value for the detector is <40. Because samples contain unknown amounts of DNA, a large range of C_T values is possible. The IPC system template DNA is added to the reaction at a fixed concentration, therefore, the NED C_T should range between 28 and 31, with a variation of 1 C_T across the standard curve samples.
**Negative Results**

No human DNA is detected when:

- No VIC® or FAM™ dye signal is detected, indicating that the human and/or male-specific targets did not amplify.
- NED™ dye signal ($C_T$ NED between 28 and 31) indicates that the IPC target was amplified; the PCR was not inhibited.

**Invalid IPC Results**

If the human and/or male-specific targets *and* the IPC target failed to amplify, then it is not possible to distinguish between the absence of DNA, PCR reaction failure, and PCR inhibition.

**IPC Results Inconclusive**

With extremely high concentrations of human genomic DNA (>10 ng/µL), competition between the human and/or male-specific and IPC PCR reactions may suppress IPC amplification for that sample. If the target amplifies with low $C_T$ and high $\Delta R_{n}$ results, it is unlikely that PCR inhibitors are present. In these cases, appearance of suppression or failure of IPC amplification render the IPC result inconclusive.

**PCR Inhibition**

Weak amplification (high $C_T$ value and low $\Delta R_{n}$ value) of the human and/or male-specific targets and no or weak amplification of the IPC may indicate PCR inhibition (partial or complete) in the sample.

Determining the Normal Range for IPC

To determine the normal range of $C_T$ values for the IPC, view the NED™ dye signal in the amplification plots for the quantification standards. If the assays were set up correctly, the reactions should show normal IPC amplification across a broad range of input DNA; that is, a NED™ $C_T$ which falls between 28 and 31 with a variation of approximately 1 $C_T$ across the standard curve.

**Evaluating PCR Inhibition**

If the IPC amplification for certain samples appears reduced relative to IPC amplification for quantification standards, the decreased IPC amplification may be interpreted as partial PCR inhibition. The IPC results can help you decide the next step:

- Proceed directly to an STR analysis of the sample
- Repeat the DNA extraction from the sample
- Perform additional cleanup of the sample to remove potential inhibitors
### Troubleshooting Amplification Plots

#### Table 5-4  Troubleshooting amplification plots

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
</table>
| \( \Delta R_n \) and \( C_T \) values inconsistent with replicates | Evaporation of reaction mixture from some wells because the Optical Adhesive Cover was not sealed to the reaction plate properly or the compression pad was not used during the run. | 1. Select the **Component** tab.  
Affected wells should generate significantly less fluorescence compared to unaffected replicates.  
2. Check the amount of solution in each well of the reaction plate.  
Wells affected by evaporation should contain less solution than unaffected wells, and they should correspond with the inconsistent results.  
For subsequent runs, make sure that the Optical Adhesive Cover is sealed to the reaction plate properly. |
| \( \Delta R_n \) and \( C_T \) values inconsistent with replicates | Incorrect volume of Quantifiler® Duo PCR Reaction Mix added to some reactions. | 1. Select the **Component** tab.  
Affected wells should generate significantly different amounts of fluorescence compared to unaffected replicates.  
2. Select the **Spectra** tab.  
Wells with the incorrect volume of Quantifiler® Duo PCR Reaction Mix should generate significantly different amounts of fluorescence compared to unaffected wells. |
### Jagged amplification plots

- **Observation:** Jagged amplification plots
- **Possible Cause:** Weak lamp or incorrect replacement.
- **Recommended Action:** Replace the lamp or make sure the existing replacement is correct.

### No defined amplification plots

- **Observation:** No defined amplification plots
- **Possible Cause:** Incorrect detector selected on the amplification plot or incorrect detector applied to the reactions when setting up the plate document. In the example, a detector that uses Cy5 as reporter dye was selected and applied in the amplification plot.
- **Recommended Action:**
  1. Make sure that the correct detector is selected on the amplification plot.
  2. If the amplification plots are still not defined, make sure settings are correct:
     a. From the plate document, double-click a well to view the Well Inspector.
     b. Verify that the detector settings are correct and reanalyze.
Abnormal $\Delta R_n$ values or negative $\Delta R_n$ values

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incorrect passive reference was selected when setting up the plate document. In the examples, <strong>Cy5, Cy3 or none</strong> was selected as passive reference, respectively.</td>
<td>1. From the plate document, double-click a well to view the Well Inspector. 2. Observe which Passive Reference is selected. <strong>Note:</strong> ROX should be selected as the Passive Reference.</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 5 Interpretation of Results

5-18 Quantifiler® Duo DNA Quantification Kit User's Manual

Abnormally low ΔRn values, straight amplification plots, and low sensitivity across the whole plate.

Incorrect PCR Reaction Mix was used to set up the reactions (e.g. Quantifiler® Human or Y PCR Reaction Mix instead of Quantifiler® Duo PCR Reaction Mix).

The first example shows the amplification plots of the standard curve wells when the Quantifiler® Human or Y PCR Reaction Mix is used.

The second example shows the amplification plots of the standard curve wells with the expected ΔRn values when the Quantifiler® Duo PCR Reaction Mix is used.

From the plate document, select the standard curve wells, click on the Amplification Plot tab, then change the ΔRn scale to linear. If the ΔRn values look like the ones in the first example, set up the reactions again with the correct PCR Reaction Mix.

Table 5-4 Troubleshooting amplification plots (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abnormally low ΔRn values, straight amplification plots, and low sensitivity across the whole plate.</td>
<td>Incorrect PCR Reaction Mix was used to set up the reactions (e.g. Quantifiler® Human or Y PCR Reaction Mix instead of Quantifiler® Duo PCR Reaction Mix). The first example shows the amplification plots of the standard curve wells when the Quantifiler® Human or Y PCR Reaction Mix is used.</td>
<td>From the plate document, select the standard curve wells, click on the Amplification Plot tab, then change the ΔRn scale to linear. If the ΔRn values look like the ones in the first example, set up the reactions again with the correct PCR Reaction Mix.</td>
</tr>
</tbody>
</table>
Assessing Quantity

Purpose
After viewing the results and assessing the quality of the results, the analyst can determine whether sufficient DNA is present to proceed with a short tandem repeat (STR) assay.

Assay Sensitivity
The Quantifiler® Duo DNA Quantification Kit can quantify 23 pg/µL of human genomic DNA in a sample. When 2.0 µL of a sample at this concentration is loaded in a reaction, the well contains approximately 7 diploid human genome equivalents. These equivalents correspond to approximately 14 copies of the Duo Human target locus and approximately 7 copies of the Duo Male target locus (Y chromosome loci are haploid).

Stochastic Effects
In the 23-pg/µL concentration range, stochastic effects, or the statistical effect of sampling alleles present at a very low copy number, can produce significant variability in assay results. When using samples containing DNA in this concentration range, perform replicate analysis to confirm true absence of DNA.

Validity
Detection and quantification of very low concentration (<100 pg) DNA samples is valid using the Quantifiler® Duo DNA Quantification Kit. However, the amount of DNA present in the sample may be below the working range of certain genotyping methods.

If Insufficient DNA Is Present
If the results from Quantifiler® Duo DNA Quantification Kit reactions indicate that insufficient DNA is present to perform an STR assay, the analyst can:

- Re-extract the DNA, then repeat the test with the Quantifiler® Duo DNA Quantification Kit before performing STR analysis.
- Concentrate the sample, then repeat the test with the Quantifiler® Duo DNA Quantification Kit before performing STR analysis.
Calculating Male : Female DNA Ratio

The Quantifiler® Duo Quantification Kit provides the quantity of human and male DNA in biological samples. From these values, one can calculate the ratio of male and female DNA using the following equation:

\[
\text{Male DNA : Female DNA Ratio} = \frac{\text{Male DNA}}{\text{Male DNA}} : \frac{(\text{Human DNA} - \text{Male DNA})}{\text{Male DNA}}
\]

All quantities in the above equation are ng/μL.

For example, assuming:

- Male DNA concentration = 2 ng/ul
- Human DNA concentration = 8 ng/ul

then the Male DNA:Female DNA ratio is:

\[
\frac{2}{2} : \frac{(8-2)}{2} = 1:3
\]

This ratio determines the extent of the mixture and is useful in determining whether to proceed with autosomal STR or Y STR analysis.

Improving Assay Performance

Assessing Sensitivity and Results

About Assay Sensitivity

Real-time PCR assays are extremely sensitive, and detection of \( C_T \) values >35 may indicate the presence of exceedingly low quantities of DNA (<3 copies). Some user laboratories have reported the detection of \( C_T \) values <40 for extraction blank and negative control samples while performing a real-time PCR reaction with the previously released Quantifiler® Kit assays.

Detection of such a low quantity of DNA can vary from amplification to amplification based on stochastic effects. Such levels may be considered background, and may not produce detectable product when the AmpF/STR® Kits are used. The same observation applies to the Quantifiler® Duo DNA Quantification Kit.
The Quantifiler® Duo DNA Quantification Kit reagents undergo rigorous quality control to ensure that the reagents are free of extraneous DNA. However, due to the extreme sensitivity of the test, background DNA from the environment can be detected on rare occasions.

Each laboratory should take standard precautions to minimize contamination in its own facility. Each laboratory should also establish a $C_T$ value above which a positive result represents background DNA only. In this way, samples that are successfully amplified using the AmpFSTR® Kits can be distinguished from those samples lacking sufficient target to generate an interpretable result.

Establishing the limits of the test is common practice in forensic laboratories when dealing with STR amplification results. Applied Biosystems recommends applying a similar approach when interpreting the results generated by the Quantifiler® Duo DNA Quantification Kit.

### About False Positive Results

When encountering false positive results (positive amplification of negative controls), note the following:

- The quantities obtained are usually well below the dynamic range of the standard curve. Therefore, these quantities may produce no STR or variable STR profiles.
- You can set a $C_T$ value threshold to proceed with STR analysis.

**Note:** Setting a $C_T$ value threshold requires further internal validation at your facility.

- It is important to distinguish between a real DNA signal due to the contamination of one reagent and a positive result due to spectral overlap between the various dyes.

**Note:** The 7500 SDS software uses a specialized multicomponenting algorithm that provides precise deconvolution of multiple dye signals in each well. This algorithm ensures minimal crosstalk when using multiple fluorophores for multiplex assays. However, a residual spectral overlap may be observed in the NTC wells, especially if the instrument is in need of calibration.
## Assessing and Troubleshooting False Positive Results

### Table 5-5  Troubleshooting false positives

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
</table>
| CT values <40 are detected in NTC wells for the Duo Human and/or Duo Male detectors. | Spectral crosstalk into the FAM™ and/or VIC® channels. | 1. From the plate document, select the NTC wells, click on the Amplification Plot tab, then change the $\Delta R_n$ scale to **linear**.  
2. If the $\Delta R_n$ values for the Duo Human (VIC® reporter dye) and/or the Duo Male (FAM™ reporter dye) detectors slowly increase until the curves cross the threshold at a late threshold cycle as shown, perform an instrument Pure Dye Spectra calibration (see the Applied Biosystems 7300/7500 Real-Time PCR System Installation and Maintenance Guide for more details on the maintenance procedures) and repeat the experiment.  
3. If the problem persists, contact Applied Biosystems Technical Support. |
| CT values <40 are detected in NTC wells for the Duo Human and/or Duo Male detectors. | Contamination of reagents due to DNA or amplified PCR products. | 1. From the plate document, select the NTC wells, click on the Amplification Plot tab, then change the $\Delta R_n$ scale to **linear**.  
2. If the $\Delta R_n$ values for the Duo Human (VIC® reporter dye) and/or the Duo Male (FAM™ reporter dye) detectors increase exponentially and the curves quickly cross the threshold and reach $\Delta R_n$ values >1 as shown, clean the work area according to the guidelines described in "Preventing PCR Contamination" on page 5-23 and repeat the experiment with a new set of reagents. |
Preventing PCR Contamination

**Laboratory Practices to Minimize False Positives**

PCR assays require special laboratory practices to avoid false positive amplifications, as detailed in Table 5-5. The high sensitivity of these assays may result in the amplification of a single DNA molecule.

To minimize false positives due to the presence of amplified material in your work area, follow these recommended laboratory practices:

- When possible, maintain separate work areas, dedicated equipment and supplies for:
  - Sample preparation
  - PCR setup
  - PCR amplification
  - Analysis of PCR products
- Wear a clean lab coat (not previously worn while handling amplified PCR products or during sample preparation) and clean gloves when preparing samples for PCR amplification.
- Change gloves whenever you suspect they are contaminated and before leaving the work area.
- Use positive-displacement pipettes or aerosol-resistant pipette tips.
- Never bring amplified PCR products into the PCR setup area.
- Open and close all sample tubes and reaction plates carefully.
- Try not to splash or spray PCR samples.
- When pipetting from a kit component tube, hold the cap of the tube in your gloved hand, or be sure to set it down on a clean, decontaminated surface.
- Keep reactions and components sealed when possible.
- Do not open sealed reaction tubes or plates after amplification.
- Clean lab benches and equipment periodically with freshly diluted 10% bleach solution.
Chapter 6

Experiments and Results
Experiments and Results

This chapter covers:

Overview ......................................................... 6-2
Developmental Validation ................................. 6-3
Overview

About This Chapter
This chapter provides results of the validation experiments performed by Applied Biosystems using the Quantifiler® Duo DNA Quantification Kit.

Importance of Validation
Although the Quantifiler® Duo DNA Quantification kit is not a DNA genotyping assay, it is intended for use before performing genotyping assays such as the AmpFSTR® PCR Amplification Kits. By testing the procedure with samples commonly encountered in forensic and parentage laboratories, the validation process establishes attributes and limitations that are critical for sound data interpretation.

Experiments
Experiments to evaluate the performance of the Quantifiler® Duo DNA Quantification Kit were performed at Applied Biosystems according to the Revised Validation Guidelines issued by the Scientific Working Group on DNA Analysis Methods (SWGDAM) published in Forensic Science Communications Vol. 6, No. 3, July 2004:


These guidelines describe the quality assurance requirements that a laboratory should follow to ensure the quality and integrity of the data and competency of the laboratory.

The experiments focus on kit performance parameters relevant to the intended use of the kits as human-specific DNA quantification assays and as a part of a forensic DNA genotyping procedure. Each laboratory using the Quantifiler® Duo DNA Quantification Kit should perform appropriate internal validation studies.
Developmental Validation

The validation studies are described with reference to the standard numbers noted in the Scientific Working Group on DNA Analysis Methods (SWGDAM) Guidelines. The stock DNA samples used for the validation study were quantified using the validation lot of the Quantifiler® Duo kit to establish baseline DNA concentrations from which the dilutions were made.

Mapping (Std. 2.1.2)

The chromosomal location of the genetic markers that are used as target regions for quantification of human and male DNA are described in this section.

Human DNA

The quantification of human DNA using the Quantifiler® Duo DNA Quantification Kit is based on the amplification of a region from the ribonuclease P RNA component H1 (RPPH1) gene:

- Official Symbol: RPPH1
- Name: ribonuclease P RNA component H1 \([Homo sapiens]\)
- Other Aliases: H1 RNA, H1RNA
- Chromosome: 14; Location: 14q11.2
- GeneID: 85495

Insert the GeneID number into the “Search For” box on the following linked page:


Male DNA

The quantification of human male DNA using the Quantifiler® Duo DNA Quantification Kit is based on the amplification of a region from the sex determining region Y (SRY) gene:

- Official Symbol: SRY
- Name: sex determining region Y \([Homo sapiens]\)
- Other Aliases: TDF, TDY
- Other Designations: essential protein for sex determination in human males; sex determining region protein; sex-determining region on Y; testis-determining factor
- Chromosome: Y; Location: Yp11.3
- GeneID: 6736
- The assay maps upstream of the reference sequence mRNA gi|4507224|ref|NM_003140.1|

Insert the GeneID number into the “Search For” box on the following linked page:

Detection (Std. 2.1.3)
Quantification of the human and human male DNA, and qualitative indication of the presence of PCR inhibitors in a biological sample are determined by the measurement of fluorescent dye released during the amplification process. The fluorescent dyes are linked to sequence specific nucleotide probes. The principle of detection and details of the assay are described in Chapter 1, “Chemistry Overview” on page 1-3 in this document.

Species Specificity (Std. 2.2)
The Quantifiler® Duo DNA Quantification Kit measures the quantity of human and human male DNA in forensic-type samples. The quantification results are further used to determine the optimal amount of DNA sample to be used for genotyping assays. Since the forensic-type samples are often contaminated with non-human DNA, specificity measurements of primers and probes in the Quantifiler® Duo DNA Quantification Kit are crucial. Specificity is confirmed through experimentation.

Experiment
Cross reactivity of primers and probes in the Quantifiler® Duo DNA Quantification Kit was examined by testing DNA from various non-human species. Human DNA samples were used as controls (see Table 6-1 for details). The DNA from non-human biological species was either obtained commercially or purified in the laboratory. For some of these DNA samples, the sex of the donor animal was unknown. For some species, multiple donor animals were tested (annotated as A and B).

Most of the reactions utilized 5.0 ng of input DNA. For a few reactions, 10 ng of input DNA was used. For the two human samples, 5.0 ng of DNA was used in the amplification reactions.
Results

The two human control samples that were tested produced the expected results as shown in Table 6-1.

<table>
<thead>
<tr>
<th>Organism</th>
<th>Sex</th>
<th>RPPH1 Average Ct</th>
<th>SRY Average Ct</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orangutan</td>
<td>Unknown</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Chimpanzee A</td>
<td>Unknown</td>
<td>40</td>
<td>32.3</td>
</tr>
<tr>
<td>Chimpanzee B</td>
<td>Unknown</td>
<td>40</td>
<td>31.1</td>
</tr>
<tr>
<td>Gorilla A</td>
<td>Unknown</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Gorilla B</td>
<td>Unknown</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Macaque</td>
<td>Unknown</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Dog</td>
<td>Unknown</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Cow</td>
<td>Unknown</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Pig</td>
<td>Unknown</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Cat</td>
<td>Unknown</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Horse</td>
<td>Unknown</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Sheep</td>
<td>Unknown</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Chicken</td>
<td>Unknown</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Fish</td>
<td>Unknown</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Rabbit</td>
<td>Unknown</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Mouse</td>
<td>Unknown</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Rat</td>
<td>Unknown</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Hamster</td>
<td>Unknown</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Human Male</td>
<td>Male</td>
<td>27</td>
<td>27.9</td>
</tr>
<tr>
<td>Human Female</td>
<td>Female</td>
<td>27.5</td>
<td>40</td>
</tr>
<tr>
<td>Dog</td>
<td>Male</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Bovine</td>
<td>Male</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Pig</td>
<td>Male</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Horse</td>
<td>Male</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Sheep</td>
<td>Male</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Chicken</td>
<td>Male</td>
<td>40</td>
<td>40</td>
</tr>
</tbody>
</table>
The Quantifiler® Duo DNA Quantification Kit:
- Detected DNA from a human male individual with a $C_T$ value of 27 (RPPH1) and 27.9 (SRY).
- Detected DNA from a human female individual with a $C_T$ value of 27.5 (RPPH1).
- Detected DNA from two chimpanzees with relatively lower efficiency, producing $C_T$ values of 32.3 and 31.1 for the SRY assay only.
- Did not detect DNA from the remaining non-human species.

Thus, the Quantifiler® Duo DNA Quantification Kit detected DNA from only one non-human species at a significantly reduced efficiency. This degree of cross-reactivity of primers and probes for higher primates is well documented.

**Table 6-1 Specificity with a non-human DNA panel**

<table>
<thead>
<tr>
<th>Species</th>
<th>Gender</th>
<th>DNA Concentration</th>
<th>Sensitivity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rabbit</td>
<td>Male</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Mouse</td>
<td>Male</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Rat</td>
<td>Male</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td><em>Escherichia coli</em></td>
<td>NA</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td><em>Pseudomonas aeruginosa</em></td>
<td>NA</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td><em>Neisseria gonorrhoeae</em></td>
<td>NA</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td><em>Staphylococcus aureus</em></td>
<td>NA</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td><em>Saccharomyces cerevisiae</em></td>
<td>NA</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td><em>Candida albicans</em></td>
<td>NA</td>
<td>40</td>
<td>40</td>
</tr>
</tbody>
</table>

Sensitivity Studies (Std. 2.3)  
Sensitivity studies were performed to determine the range of DNA concentrations that can be reliably quantified and detected using the Quantifiler® Duo assay.
Experiment

Two human male DNA samples obtained from commercial sources (Table 6-2) were each diluted to obtain concentrations of 20.0, 5.0, 1.0, 0.1, 0.05, 0.04, 0.03, 0.023, 0.0115, 0.00575, 0.002875 and 0.00144 ng/µL in TBE0.1 buffer. Each dilution was quantified in triplicate using the Quantifiler® Duo DNA Quantification Kit. For each 25-µL reaction, 2.0 µL of DNA sample was used.

Table 6-2 Human DNA samples tested for sensitivity

<table>
<thead>
<tr>
<th>Sample</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Human male blood (pool)</td>
</tr>
<tr>
<td>2</td>
<td>Human male blood (single source)</td>
</tr>
</tbody>
</table>

Results

The quantities of DNA obtained from the Quantifiler® Duo DNA Quantification Kit were very similar to the expected quantities across a range of concentrations from 20 ng/µL to 23 pg/µL (as shown in Table 6-3). Furthermore, quantities as low as 11.5 pg/µL of human DNA were reproducibly detected across all replicates using the Quantifiler® Duo DNA Quantification Kit (as shown in Table 6-3).

At concentrations of 5.75 pg/µL and below, human DNA cannot be reproducibly detected across all replicates due to stochastic variation in the amplification efficiency resulting from low DNA input amounts (Table 6-3). Stochastic effects provide greater variation in the quantification results from samples containing lower quantities of DNA. In general, for samples containing DNA at concentrations of 0.1 ng/µL or less, it is necessary to add the maximum volume of DNA extract to the AmpF/STR® kit STR reaction.

A plot of the C_T values versus the known DNA quantities (see Figure 6-1 and Figure 6-2) showed the expected log-linear relationship between the two quantities from 20 ng/µL to 23 pg/µL. For each dilution series, the data points formed an acceptable standard curve.
Table 6-3  Sensitivity using the Quantifiler® Duo DNA Quantification Kit

<table>
<thead>
<tr>
<th>Sample</th>
<th>Expected Quantity ng/µL</th>
<th>Measured Quantity (RPPH1) ng/µL</th>
<th>Measured Quantity (SRY) ng/µL</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20</td>
<td>18.500</td>
<td>19.540</td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td>4.000</td>
<td>4.330</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0.832</td>
<td>0.909</td>
</tr>
<tr>
<td>1</td>
<td>0.1</td>
<td>0.099</td>
<td>0.111</td>
</tr>
<tr>
<td>1</td>
<td>0.05</td>
<td>0.050</td>
<td>0.048</td>
</tr>
<tr>
<td>1</td>
<td>0.04</td>
<td>0.039</td>
<td>0.053</td>
</tr>
<tr>
<td>1</td>
<td>0.03</td>
<td>0.026</td>
<td>0.033</td>
</tr>
<tr>
<td>1</td>
<td>0.023</td>
<td>0.020</td>
<td>0.022</td>
</tr>
<tr>
<td>1</td>
<td>0.01150</td>
<td>0.014</td>
<td>0.009</td>
</tr>
<tr>
<td>1</td>
<td>0.00575</td>
<td>0.010</td>
<td>0.007</td>
</tr>
<tr>
<td>1</td>
<td>0.00288</td>
<td>----</td>
<td>0.000</td>
</tr>
<tr>
<td>1</td>
<td>0.00144</td>
<td>----</td>
<td>0.006</td>
</tr>
<tr>
<td>2</td>
<td>20</td>
<td>20.910</td>
<td>20.383</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
<td>4.943</td>
<td>4.800</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>0.802</td>
<td>0.751</td>
</tr>
<tr>
<td>2</td>
<td>0.1</td>
<td>0.096</td>
<td>0.108</td>
</tr>
<tr>
<td>2</td>
<td>0.05</td>
<td>0.056</td>
<td>0.058</td>
</tr>
<tr>
<td>2</td>
<td>0.04</td>
<td>0.038</td>
<td>0.039</td>
</tr>
<tr>
<td>2</td>
<td>0.03</td>
<td>0.038</td>
<td>0.031</td>
</tr>
<tr>
<td>2</td>
<td>0.023</td>
<td>0.022</td>
<td>0.033</td>
</tr>
<tr>
<td>2</td>
<td>0.01150</td>
<td>0.015</td>
<td>0.016</td>
</tr>
<tr>
<td>2</td>
<td>0.00575</td>
<td>0.010</td>
<td>----</td>
</tr>
<tr>
<td>2</td>
<td>0.00288</td>
<td>0.006</td>
<td>0.007</td>
</tr>
<tr>
<td>2</td>
<td>0.00144</td>
<td>----</td>
<td>----</td>
</tr>
</tbody>
</table>
Developmental Validation

Figure 6-1  Sensitivity for the male target using the Quantifiler®
Duo DNA Quantification Kit
The stability studies were conducted to demonstrate the performance of the Quantifiler® Duo kit when used to quantify samples subjected to environmental and chemical insults, such as those samples containing PCR inhibitors and degraded DNA. Forensic DNA extracts commonly contain compounds that inhibit the amplification of nucleic acids. These PCR inhibitors can interfere with the reaction and cause varying levels of reduced PCR efficiency, including complete inhibition of PCR.

A wide variety of compounds that may inhibit PCR have been reported. One example is hematin, which has been found in DNA samples extracted from blood stains. Because the solubility of hematin is similar to that of DNA, it is thought that hematin is co-extracted and purified with the DNA. The presence of hematin in DNA samples may interfere with PCR by inhibiting DNA polymerase activity. Humic acid is yet another example of a PCR inhibitor that has been found in forensic-type samples contaminated with soil.
Experiment 1

Human genomic DNA was mixed with varying concentrations of hematin and humic acid to assess the impact of inhibitors on both the Quantifiler Duo reactions and the subsequent STR reactions performed using the AmpFSTR Identifiler Kit. Hematin concentrations of 0, 2.5, 5.0, 7.5, 10, 12.5, 15, 17.5, 20, and 40 µM and humic acid concentrations of 0, 1.0, 2.0, 3.0, 3.75, 7.5, 11.25, 15, and 30 ng/µL were evaluated. The concentrations described here are final concentrations of respective inhibitor in 25 µL PCR when 2 µL of sample is added. 2 µL of each sample, containing approximately 1.0 ng of DNA, was quantified in triplicate using the Quantifiler® Duo DNA Quantification Kit. The same amount of each replicate sample was subsequently added to AmpFSTR® Identifiler® PCR Amplification Kit reactions in order to have the same final concentration of inhibitor in both the quantification and the STR reaction. The STR reactions were analyzed on an Applied Biosystems 3130xl Genetic Analyzer instrument. Data were analyzed using GeneMapper® ID Software v3.2.1.

Results 1

The histograms (Figure 6-3 and Figure 6-4) illustrate higher C_T values as the concentrations of hematin and humic acid increased. C_T values were relatively stable up to 7.5 µM hematin and 3.0 ng/µL humic acid, with results displaying more pronounced C_T shifts at higher concentrations. As the concentrations of hematin and humic acid increased, the PCR efficiency in the Quantifiler® Duo DNA Quantification Kit decreased. Complete inhibition of the amplification occurred at 15.0 µM hematin and 11.25 ng/µL humic acid.

In general, the C_T values for all targets (human, human male and IPC) were affected similarly using comparable concentrations of inhibitors (see Figure 6-3 and Figure 6-4).
Chapter 6  Experiments and Results

Figure 6-3  $C_T$ values for hematin-inhibited samples using the Quantifiler® Duo DNA Quantification Kit

Figure 6-4  $C_T$ values for humic acid-inhibited samples using the Quantifiler® Duo DNA Quantification Kit
STR analysis was performed using the Identifiler® Kit. The volume of extract used for STR amplification was equal to the volume used for quantification (2 µL). The Identifiler® Kit results (Figure 6-6 and Figure 6-8) were consistent with the results from the Quantifiler® Duo DNA Quantification Kit (Figure 6-5 and Figure 6-7): As the concentrations of hematin and humic acid increased (indicated by the increasing IPC C_T values), the overall STR peak heights decreased. Complete STR profiles were obtained at 10 µM hematin and 3.75 ng/µL humic acid. The STR amplification reaction was completely inhibited at 40 µM hematin and 30 ng/µL humic acid. Thus, the results from the Quantifiler® Duo DNA Quantification Kit provided reasonable predictions of samples that would produce lower quality STR profiles due to the presence of a PCR inhibitor.

![IPC C_T in hematin inhibited samples](image_url)

**Figure 6-5** IPC C_T values obtained for samples containing a range of hematin concentrations
Figure 6-6 Identifiler® Kit profiles obtained for samples containing a range of hematin concentrations
Figure 6-7  IPC $C_T$ values obtained for samples containing a range of humic acid concentrations.
Figure 6-8  Identifiler® Kit profiles obtained for samples containing a range of humic acid concentrations
Experiment 2

In this experiment the same samples described in Experiment 1 (Human genomic DNA mixed with varying concentrations of hematin and humic acid) were analyzed. However, in this experiment 2 µL of each sample, containing approximately 1.0 ng of DNA, was quantified in triplicate using the Quantifiler® Duo DNA Quantification Kit, and the quantification results from the RPPH1 human target were used to determine the sample volume necessary for the autosomal STR reaction. In this way, the impact of the inhibitor concentration on the quantification results was evaluated. Further, the effect of the altered quantification results on the quality of the STR profile was studied for both the AmpF/STR® Identifiler® Kit and the AmpF/STR® MiniFiler™ Kit.

1.0 ng of template DNA was used in the PCR amplification reaction using the AmpF/STR® Identifiler® Kit. For the AmpF/STR® MiniFiler™ PCR Amplification Kit reactions, varying quantities of input DNA including 0.1, 0.25 and 0.5 ng were used. The electropherograms displayed in Figure 6-12 and Figure 6-14 represent the optimal input DNA amounts at the corresponding inhibitor level. For simplicity, in the STR panels (Figure 6-9 through Figure 6-14) we refer to the inhibited samples using the inhibitor concentration indicated in Table 6-4 in the Sample Name column (final concentration in the quantification reaction, or 2 µL in a 25 µL reaction volume). However, the actual final inhibitor concentration in the STR reactions will vary and is determined by the volume of sample used for amplification.

Results 2

The presence of hematin and humic acid adversely affected the quantification of DNA in a sample due to the inhibition of PCR. The quantification results obtained from each sample are summarized in Table 6-4 and indicate that the quantity of DNA was underestimated when the concentrations of hematin and humic acid were increased. Hematin and humic acid at concentrations higher than 12.5 µM and 7.5 ng/µL, respectively, completely inhibited the PCR, and no DNA was detectable in these samples.
## Table 6-4  Quantification of inhibited samples using the Quantifiler® Duo DNA Quantification Kit

<table>
<thead>
<tr>
<th>Sample Name</th>
<th>Inhibitor Name</th>
<th>Quantity (SRY) ng/µL</th>
<th>StdDev (SRY)</th>
<th>Quantity (RPPH1) ng/µL</th>
<th>StdDev (RPPH1)</th>
<th>C&lt;sub&gt;T&lt;/sub&gt; value (IPC)</th>
<th>StdDev (IPC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 µM</td>
<td>Hematin</td>
<td>0.411</td>
<td>0.033</td>
<td>0.397</td>
<td>0.045</td>
<td>29.647</td>
<td>0.112</td>
</tr>
<tr>
<td>2.5 µM</td>
<td>Hematin</td>
<td>0.406</td>
<td>0.099</td>
<td>0.399</td>
<td>0.029</td>
<td>29.833</td>
<td>0.078</td>
</tr>
<tr>
<td>5 µM</td>
<td>Hematin</td>
<td>0.393</td>
<td>0.041</td>
<td>0.358</td>
<td>0.045</td>
<td>29.677</td>
<td>0.123</td>
</tr>
<tr>
<td>7.5 µM</td>
<td>Hematin</td>
<td>0.371</td>
<td>0.035</td>
<td>0.253</td>
<td>0.030</td>
<td>30.050</td>
<td>0.122</td>
</tr>
<tr>
<td>10 µM</td>
<td>Hematin</td>
<td>0.092</td>
<td>0.013</td>
<td>0.024</td>
<td>0.010</td>
<td>31.753</td>
<td>0.377</td>
</tr>
<tr>
<td>12.5 µM</td>
<td>Hematin</td>
<td>0.007</td>
<td>0.004</td>
<td>0.000</td>
<td>---</td>
<td>35.347</td>
<td>1.048</td>
</tr>
<tr>
<td>15 µM</td>
<td>Hematin</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
<td>40.000</td>
<td>---</td>
</tr>
<tr>
<td>17.5 µM</td>
<td>Hematin</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
<td>40.000</td>
<td>---</td>
</tr>
<tr>
<td>20 µM</td>
<td>Hematin</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
<td>40.000</td>
<td>---</td>
</tr>
<tr>
<td>40 µM</td>
<td>Hematin</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
<td>40.000</td>
<td>---</td>
</tr>
<tr>
<td>0 ng/µL</td>
<td>Humic acid</td>
<td>0.411</td>
<td>0.033</td>
<td>0.397</td>
<td>0.045</td>
<td>29.647</td>
<td>0.112</td>
</tr>
<tr>
<td>1 ng/µL</td>
<td>Humic acid</td>
<td>0.381</td>
<td>0.077</td>
<td>0.359</td>
<td>0.034</td>
<td>29.783</td>
<td>0.054</td>
</tr>
<tr>
<td>2 ng/µL</td>
<td>Humic acid</td>
<td>0.370</td>
<td>0.060</td>
<td>0.244</td>
<td>0.029</td>
<td>29.813</td>
<td>0.071</td>
</tr>
<tr>
<td>3 ng/µL</td>
<td>Humic acid</td>
<td>0.275</td>
<td>0.058</td>
<td>0.105</td>
<td>0.023</td>
<td>30.263</td>
<td>0.142</td>
</tr>
<tr>
<td>3.75 ng/µL</td>
<td>Humic acid</td>
<td>0.155</td>
<td>0.041</td>
<td>0.055</td>
<td>0.016</td>
<td>30.807</td>
<td>0.411</td>
</tr>
<tr>
<td>7.5 ng/µL</td>
<td>Humic acid</td>
<td>0.006</td>
<td>0.005</td>
<td>0.000</td>
<td>---</td>
<td>35.207</td>
<td>1.540</td>
</tr>
<tr>
<td>11.25 ng/µL</td>
<td>Humic acid</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
<td>40.000</td>
<td>---</td>
</tr>
<tr>
<td>15 ng/µL</td>
<td>Humic acid</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
<td>40.000</td>
<td>---</td>
</tr>
<tr>
<td>30 ng/µL</td>
<td>Humic acid</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
<td>40.000</td>
<td>---</td>
</tr>
</tbody>
</table>
The results of the STR analysis with the Identifiler® kit, using 1.0 ng of template DNA for PCR amplification, are presented in Figure 6-9 and Figure 6-10. The volume of the extract used for amplification was based on the quantification results (RPPH1 target) summarized in Table 6-4.

A full and interpretable profile was obtained for samples labeled as 0 µM, 2.5 µM, and 5 µM hematin as well as 0 ng/µL, 1 ng/µL, and 2 ng/µL humic acid. Samples labeled as 7.5 µM hematin and 3 ng/µL humic acid exhibited partial profiles. All other samples did not provide any STR profile. As previously described, these concentrations correspond to the final inhibitor concentration in the quantification reaction (2 µL in a 25-µL reaction volume) and not to the actual final inhibitor concentration in the STR reaction. The results indicate that an upward shift in the IPC C\textsubscript{T} value with the Quantifiler® Duo DNA Quantification Kit can be used to signal that STR analysis may result in a partial profile or in the inability to obtain an STR profile.
Figure 6-9  Identifiler® Kit profiles obtained for samples containing a range of hematin concentrations. Label corresponds to inhibitor concentration in the Quantifiler® Duo reaction.
Figure 6-10  Identifiler® Kit profiles obtained for samples containing a range of humic acid concentrations. Label corresponds to inhibitor concentration in the Quantifier® Duo reaction.
The MiniFiler™ kit is designed to obtain STR profiles from compromised samples such as those which may be inhibited and/or degraded. The results of the STR analysis using the MiniFiler™ Kit, with varying DNA input amounts, are presented in Figure 6-11, Figure 6-12, Figure 6-13, and Figure 6-14.

Control samples that did not contain any inhibitor provided complete profiles when using 0.25 ng of template DNA for amplification. Inhibited samples labeled as 2.5 μM, 5.0 μM, 7.5 μM hematin and 1 ng/μL and 2 ng/μL humic acid provided complete profiles when using 0.1 ng of DNA template, as quantified by the Quantifiler® Duo DNA Quantification Kit.

Using 10 μL of all the other samples (because of low or no quantification results) resulted in either partial or uninterpretable results (see Figure 6-11, panels E-J and Figure 6-13, panels F-I). These results are consistent with observations of an IPC C_T shift during quantification using the Quantifiler® Duo kit.

Every PCR system; e.g., Quantifiler® Duo, Identifiler®, and MiniFiler™ Kits, has a unique reagent formulation that provides a varying response to samples containing inhibitors. When samples labeled as 10 μM, 12.5 μM, 15 μM, 17.5 μM, 20 μM, 40 μM hematin and 3 ng/μL, 3.75 μL, 7.5 ng/μL, 11.25 ng/μL, 15 ng/μL, 30 ng/μL humic acid were diluted (at 1:20 or 1:50), conclusive interpretable profiles were provided when amplified using the MiniFiler™ Kit (Figure 6-12 and Figure 6-14). As previously described, these concentrations correspond to the final inhibitor concentration in the quantification reaction and not to the actual final concentration in the STR reaction.
Figure 6-11  MiniFiler™ Kit analysis of hematin-inhibited samples before dilution of highly inhibited samples

Note: 0.25 ng of human DNA is used for amplification of the sample in panel A. 0.1 ng of human DNA is used for amplification of samples in panels B, C, and D. 10 µL of the extract is used for amplification of samples in panels E through J. Label corresponds to inhibitor concentration in the Quantifiler® Duo reaction.
Figure 6-12  MiniFiler™ Kit analysis of hematin-inhibited samples after dilution of highly inhibited samples

Note: 0.25 ng of human DNA is used for amplification of the sample in panel A. 0.1 ng of human DNA is used for amplification of samples in panels B, C, and D. 10 µL of the diluted extract as indicated is used for amplification of samples in panels E through J. Label corresponds to inhibitor concentration in the Quantifiler® Duo reaction.
Figure 6-13  MiniFiler™ Kit analysis of humic acid-inhibited samples before dilution of highly inhibited samples

**Note:** 0.25 ng of human DNA is used for amplification of the sample in panel A. 0.1 ng of human DNA is used for amplification of samples in panels B and C. 0.05 ng of human DNA is used for amplification of the sample in panel D. 0.03 ng of human DNA is used for amplification of the sample in panel E. 10 µL of the extract is used for amplification of the samples in panels F, G, H and I. Label corresponds to inhibitor concentration in the Quantifiler® Duo reaction.
Figure 6-14  MiniFiler™ Kit analysis of humic acid-inhibited samples after dilution of highly inhibited samples

**Note:** 0.25 ng of human DNA is used for amplification of the sample in panel A. 0.1 ng of human DNA is used for amplification of samples in panels B and C. 10 µL of the diluted extract as indicated is used for amplification of samples in panels D through I. Label corresponds to inhibitor concentration in the Quantifiler® Duo reaction.
Stability Studies: Degraded DNA Studies (Std. 2.4)

Forensic samples may be exposed to environmental conditions that degrade DNA molecules and reduce amplification efficiency in PCR reactions. Exposure to environmental conditions may cause fragmentation of full length DNA molecules and can reduce the overall concentration of amplifiable DNA. Because of such potential occurrences, the validation of forensic DNA methods involves studies of the effects of degradation on the amplification and detection of DNA.

Degraded DNA samples were tested with the Quantifiler® Duo DNA Quantification Kit to determine the quantity of amplifiable DNA at increasing levels of degradation. Results obtained using the RPPH1 human target of the Quantifiler® Duo DNA Quantification Kit were used to calculate DNA input for subsequent STR analysis.

Experiment

A sample of high-molecular weight human-genomic DNA was used to generate a series of samples with varying levels of degradation. 1µg of DNA (100 µL reaction at 10 ng/µL concentration) was treated for 20 minutes using increasing quantities of the DNase I enzyme; 0.002, 0.01, 0.02, 0.05, 0.1 and 0.2 units. Samples were run on a 4% agarose gel for 25 minutes and visualized by staining with ethidium bromide to estimate the extent of degradation. The degraded DNA samples were quantified with the Quantifiler® Duo DNA Quantification Kit.

Results

Agarose gel electrophoresis showed that DNase I treatment produced DNA fragments with sizes of 100 basepairs (bp) or less, when 0.1 unit of DNase was used (Figure 6-15).
Figure 6-15  DNase I degradation of human genomic DNA

Lower amounts of amplifiable DNA were detected using the Quantifiler® Duo DNA Quantification Kit for those samples treated with higher amounts of DNase I. According to results from the Quantifiler® Duo DNA Quantification Kit (RPPH1 target), the amount of amplifiable DNA decreased from about 7.69 ng/µL to 3.43 ng/µL when 0.02 units of DNase I was used, and to 0.03 ng/µL when 0.2 units of DNase I was used. Similar values were obtained from the SRY target assay.
Table 6-5  Quantifier® Duo DNA Quantification Kit results

<table>
<thead>
<tr>
<th>Sample Name</th>
<th>DNase I Units</th>
<th>Quantity (SRY) ng/µL</th>
<th>StdDev (SRY)</th>
<th>Quantity (RPPH1) ng/µL</th>
<th>StdDev (RPPH1)</th>
<th>C&lt;sub&gt;T&lt;/sub&gt; value (IPC)</th>
<th>StdDev (IPC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>7.07</td>
<td>0.08</td>
<td>7.69</td>
<td>0.64</td>
<td>29.61</td>
<td>0.24</td>
</tr>
<tr>
<td>2</td>
<td>0.002</td>
<td>5.92</td>
<td>0.20</td>
<td>6.51</td>
<td>0.39</td>
<td>29.60</td>
<td>0.13</td>
</tr>
<tr>
<td>3</td>
<td>0.01</td>
<td>4.77</td>
<td>0.06</td>
<td>5.11</td>
<td>0.13</td>
<td>29.67</td>
<td>0.11</td>
</tr>
<tr>
<td>4</td>
<td>0.02</td>
<td>3.23</td>
<td>0.10</td>
<td>3.43</td>
<td>0.33</td>
<td>29.75</td>
<td>0.08</td>
</tr>
<tr>
<td>5</td>
<td>0.05</td>
<td>0.50</td>
<td>0.04</td>
<td>0.57</td>
<td>0.13</td>
<td>29.77</td>
<td>0.07</td>
</tr>
<tr>
<td>6</td>
<td>0.1</td>
<td>0.10</td>
<td>0.01</td>
<td>0.08</td>
<td>0.01</td>
<td>29.90</td>
<td>0.11</td>
</tr>
<tr>
<td>7</td>
<td>0.2</td>
<td>0.02</td>
<td>0.01</td>
<td>0.03</td>
<td>0.01</td>
<td>29.83</td>
<td>0.05</td>
</tr>
</tbody>
</table>

Increasing degradation

Samples 1 and 2
Sample 3
Sample 4
Sample 5
Sample 6
Sample 7

Figure 6-16  Degraded DNA: Quantifier® Duo RPPH1 amplification plot
1.0 ng of each sample in the degraded DNA series was added to Identifiler® Kit reactions based on DNA quantification results obtained using the Quantifiler® Duo DNA Quantification Kit (RPH1 human target). As the extent of degradation increased, the concentration of amplifiable DNA decreased, resulting in the need to add a higher volume of sample to the subsequent PCR reaction. 10 µL of sample was added to the Identifiler® Kit reactions for those samples containing 0.1 ng/µL DNA or less. The peak heights (rfu values) of the alleles for STR loci with longer amplicons decreased for those degraded samples generated with 0.01 and higher units of DNase I (samples 3 to 7). However, complete interpretable STR profiles were obtained for samples generated with up to 0.02 units of DNase I (samples 1 to 4). Partial STR profiles were obtained for those samples generated with 0.05 and higher units of DNase I (samples 5 to 7) (Figure 6-18).
Developmental Validation

Quantifiler® Duo DNA Quantification Kit User’s Manual

Based on the DNA quantification results from the RPPH1 human target of the Quantifiler® Duo DNA Quantification Kit, 0.25 ng of each DNA sample was added to MiniFiler™ Kit reactions. The data is presented in Figure 6-19. Conclusive and complete STR profiles were obtained for samples that were generated using up to 0.02 units of DNase I (samples 1 to 4). The samples that were generated using up to 0.05 and 0.1 units of DNase I (samples 5 and 6) provided interpretable profiles; however, the amplitude (rfus) of the alleles for STR loci with longer amplicons decreased. Samples that were generated using 0.2 units of DNase I (sample 7) when amplified using 0.1 ng of template DNA provided interpretable profiles with low amplitude (rfus) for all loci.

The results indicate that interpretable profiles can be recovered from all the degraded samples generated in this study when using the Minifiler™ Kit.
The MiniFiler™ Kit is specifically designed to obtain STR profiles from compromised samples. The size range of the amplicons generated using the MiniFiler™ Kit is relatively smaller (70 to 283 bases) than those generated using the Identifiler® Kit (102 to 359 bases) and therefore the success rate is higher, as demonstrated by the results.

Figure 6-19  STR analysis of samples from the degraded DNA Series using the MiniFiler™ Kit

In general, these results demonstrate that the Quantifiler® Duo DNA Quantification Kit can be used to assess the amount of amplifiable DNA in a degraded sample. At extreme levels of degradation, it may not be possible to obtain results from the Quantifiler® Duo DNA Quantification Kit or the STR kits.
Reproducibility Study (Std 2.5)

Replicate analysis of human DNA samples was performed using the Quantifiler® Duo Kit to assess the reproducibility of the quantification results obtained.

Experiment

Four male and one female genomic DNA samples were tested to assess the reproducibility of the quantification results (Table 6-6). The DNA samples were diluted from initial estimated concentrations to 20.0, 10.0, 1.0, 0.1 and 0.05 ng/µL. All dilutions were made in T10E0.1 Buffer. All samples and dilutions were tested in triplicate using the Quantifiler® Duo DNA Quantification Kit. Three different runs were performed. For each sample reaction the $C_T$ values were obtained and the DNA quantities calculated. The mean quantity and standard deviation were calculated for each sample dilution. The 95% confidence interval values were calculated as the mean of the DNA quantity, ± 2 standard deviation units for each sample, and expressed as a percentage of the mean quantification result.

Table 6-6 Human DNA samples tested for reproducibility

<table>
<thead>
<tr>
<th>Sample Name</th>
<th>Source</th>
<th>Sex</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Human blood (single source)</td>
<td>Male</td>
</tr>
<tr>
<td>B</td>
<td>Human blood (single source)</td>
<td>Male</td>
</tr>
<tr>
<td>C</td>
<td>Human blood (pool)</td>
<td>Male</td>
</tr>
<tr>
<td>D</td>
<td>Human blood (single source)</td>
<td>Male</td>
</tr>
<tr>
<td>E</td>
<td>Human blood (single source)</td>
<td>Female</td>
</tr>
</tbody>
</table>

Results

The following table shows the DNA quantity calculated for all samples and dilutions tested for all three runs using the Quantifiler® Duo DNA Quantification Kit (Table 6-7).
### Table 6-7 Reproducibility using the Quantifiler® Duo Kit

<table>
<thead>
<tr>
<th>Sample</th>
<th>Sample Dilution (ng/µL)</th>
<th>Mean Qty SRY (ng/µL)</th>
<th>Std Dev SRY</th>
<th>95% Conf. SRY (± %)</th>
<th>Mean Qty RPPH1 (ng/µL)</th>
<th>Std Dev RPPH1</th>
<th>95% Conf. RPPH1 (± %)</th>
<th>IPC Ct</th>
<th>Std Dev IPC Ct</th>
<th>95% Conf. IPC (± %)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>20</td>
<td>20.10</td>
<td>1.051</td>
<td>10.46</td>
<td>21.15</td>
<td>0.804</td>
<td>7.60</td>
<td>29.70</td>
<td>0.037</td>
<td>0.25</td>
</tr>
<tr>
<td>A</td>
<td>10</td>
<td>8.98</td>
<td>0.400</td>
<td>13.36</td>
<td>9.11</td>
<td>0.341</td>
<td>11.49</td>
<td>29.73</td>
<td>0.034</td>
<td>0.23</td>
</tr>
<tr>
<td>A</td>
<td>1</td>
<td>0.85</td>
<td>0.109</td>
<td>17.84</td>
<td>0.87</td>
<td>0.051</td>
<td>8.67</td>
<td>29.92</td>
<td>0.034</td>
<td>0.23</td>
</tr>
<tr>
<td>A</td>
<td>0.10</td>
<td>0.08</td>
<td>0.007</td>
<td>25.83</td>
<td>0.09</td>
<td>0.015</td>
<td>17.86</td>
<td>29.97</td>
<td>0.039</td>
<td>0.26</td>
</tr>
<tr>
<td>A</td>
<td>0.05</td>
<td>0.05</td>
<td>0.028</td>
<td>34.00</td>
<td>0.04</td>
<td>0.002</td>
<td>63.43</td>
<td>30.00</td>
<td>0.032</td>
<td>0.21</td>
</tr>
<tr>
<td>B</td>
<td>20</td>
<td>23.09</td>
<td>2.219</td>
<td>19.23</td>
<td>24.36</td>
<td>1.656</td>
<td>13.59</td>
<td>29.79</td>
<td>0.038</td>
<td>0.25</td>
</tr>
<tr>
<td>B</td>
<td>10</td>
<td>11.22</td>
<td>0.485</td>
<td>1.45</td>
<td>11.49</td>
<td>0.529</td>
<td>15.11</td>
<td>29.77</td>
<td>0.046</td>
<td>0.31</td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>1.15</td>
<td>0.142</td>
<td>20.76</td>
<td>1.14</td>
<td>0.083</td>
<td>29.23</td>
<td>29.89</td>
<td>0.030</td>
<td>0.20</td>
</tr>
<tr>
<td>B</td>
<td>0.10</td>
<td>0.11</td>
<td>0.013</td>
<td>42.93</td>
<td>0.10</td>
<td>0.008</td>
<td>42.32</td>
<td>29.98</td>
<td>0.040</td>
<td>0.27</td>
</tr>
<tr>
<td>B</td>
<td>0.05</td>
<td>0.05</td>
<td>0.015</td>
<td>16.92</td>
<td>0.06</td>
<td>0.007</td>
<td>43.10</td>
<td>29.98</td>
<td>0.012</td>
<td>0.08</td>
</tr>
<tr>
<td>C</td>
<td>20</td>
<td>23.11</td>
<td>0.821</td>
<td>7.10</td>
<td>22.51</td>
<td>0.294</td>
<td>2.61</td>
<td>29.62</td>
<td>0.055</td>
<td>0.37</td>
</tr>
<tr>
<td>C</td>
<td>10</td>
<td>9.25</td>
<td>0.601</td>
<td>35.03</td>
<td>8.72</td>
<td>0.562</td>
<td>32.37</td>
<td>29.67</td>
<td>0.053</td>
<td>0.36</td>
</tr>
<tr>
<td>C</td>
<td>1</td>
<td>0.89</td>
<td>0.039</td>
<td>10.40</td>
<td>0.82</td>
<td>0.027</td>
<td>5.40</td>
<td>29.81</td>
<td>0.057</td>
<td>0.38</td>
</tr>
<tr>
<td>C</td>
<td>0.10</td>
<td>0.11</td>
<td>0.027</td>
<td>10.00</td>
<td>0.10</td>
<td>0.008</td>
<td>23.96</td>
<td>29.89</td>
<td>0.053</td>
<td>0.36</td>
</tr>
<tr>
<td>C</td>
<td>0.05</td>
<td>0.04</td>
<td>0.020</td>
<td>68.07</td>
<td>0.04</td>
<td>0.008</td>
<td>90.52</td>
<td>29.81</td>
<td>0.047</td>
<td>0.32</td>
</tr>
<tr>
<td>D</td>
<td>20</td>
<td>26.49</td>
<td>2.116</td>
<td>15.98</td>
<td>27.28</td>
<td>1.835</td>
<td>13.45</td>
<td>29.99</td>
<td>0.106</td>
<td>0.71</td>
</tr>
<tr>
<td>D</td>
<td>10</td>
<td>13.09</td>
<td>0.596</td>
<td>12.20</td>
<td>13.26</td>
<td>0.261</td>
<td>9.44</td>
<td>29.87</td>
<td>0.028</td>
<td>0.19</td>
</tr>
<tr>
<td>D</td>
<td>1</td>
<td>1.26</td>
<td>0.136</td>
<td>8.54</td>
<td>1.22</td>
<td>0.081</td>
<td>16.18</td>
<td>29.76</td>
<td>0.055</td>
<td>0.37</td>
</tr>
<tr>
<td>D</td>
<td>0.10</td>
<td>0.12</td>
<td>0.032</td>
<td>43.59</td>
<td>0.12</td>
<td>0.008</td>
<td>28.35</td>
<td>30.02</td>
<td>0.034</td>
<td>0.22</td>
</tr>
<tr>
<td>D</td>
<td>0.05</td>
<td>0.07</td>
<td>0.021</td>
<td>14.12</td>
<td>0.06</td>
<td>0.006</td>
<td>22.12</td>
<td>29.97</td>
<td>0.042</td>
<td>0.28</td>
</tr>
<tr>
<td>E</td>
<td>20</td>
<td>female</td>
<td>----</td>
<td>----</td>
<td>24.91</td>
<td>0.586</td>
<td>4.70</td>
<td>29.97</td>
<td>0.023</td>
<td>0.16</td>
</tr>
<tr>
<td>E</td>
<td>10</td>
<td>female</td>
<td>----</td>
<td>----</td>
<td>12.11</td>
<td>0.486</td>
<td>8.94</td>
<td>29.87</td>
<td>0.007</td>
<td>0.04</td>
</tr>
<tr>
<td>E</td>
<td>1</td>
<td>female</td>
<td>----</td>
<td>----</td>
<td>1.14</td>
<td>0.049</td>
<td>6.55</td>
<td>29.77</td>
<td>0.018</td>
<td>0.12</td>
</tr>
<tr>
<td>E</td>
<td>0.10</td>
<td>female</td>
<td>----</td>
<td>----</td>
<td>0.12</td>
<td>0.016</td>
<td>21.07</td>
<td>29.73</td>
<td>0.089</td>
<td>0.60</td>
</tr>
<tr>
<td>E</td>
<td>0.05</td>
<td>female</td>
<td>----</td>
<td>----</td>
<td>0.06</td>
<td>0.008</td>
<td>67.71</td>
<td>29.71</td>
<td>0.047</td>
<td>0.32</td>
</tr>
</tbody>
</table>
The 95% confidence interval shows the approximate range expected for results when using the Quantifiler® Duo DNA Quantification Kit. The average 95% confidence interval is ± 24.2% and ± 21.4% for the human and the male target, respectively.

The reproducibility results for the samples containing 1 ng/µL are shown graphically in Figure 6-20. At this concentration, the range of standard deviations for each target is:

- Human Target: 0.027 to 0.083
- Male Target: 0.039 to 0.142

![Reproducibility graph](image)
This experiment was performed to evaluate different sample types that are commonly processed in a forensic laboratory.

**Experiment**

A variety of forensic-type samples (Table 6-8) were prepared using semen, saliva and blood obtained from one or two male individual donors (a and b). The blood samples were spiked with inhibitors, spotted onto fabric/filter paper, and organically extracted. The saliva samples were spotted onto swabs and the semen samples were spotted onto fabric. A subset of these samples (1-4) were also extracted using other commercially available methods including Chelex® resin, the QIAGEN QIAamp® DNA Blood Mini Kit and the Promega DNA IQ™ Kit. For details on the preparation of the samples see Table 6-8.

Extracted DNA was quantified in triplicate using the Quantifiler® Duo DNA Quantification Kit. Based on the results from the Quantifiler Duo kit (RPPH1 human target), approximately 1.0 ng of human genomic DNA was added to each Identifiler® Kit reaction and approximately 0.1 ng of human genomic DNA was added to each MiniFiler™ Kit reaction.

**Table 6-8 Preparation of samples**

<table>
<thead>
<tr>
<th>Sample</th>
<th>Sample Type</th>
<th>Volume and Substrate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Saliva Swab (a)</td>
<td>50 µL on cotton swab</td>
</tr>
<tr>
<td>2</td>
<td>Saliva Swab (b)</td>
<td>50 µL on cotton swab</td>
</tr>
<tr>
<td>3</td>
<td>Blood Stain (a)</td>
<td>5 µL on fabric</td>
</tr>
<tr>
<td>4</td>
<td>Blood Stain (b)</td>
<td>5 µL on fabric</td>
</tr>
<tr>
<td>5</td>
<td>Blood Stain</td>
<td>5 µL on denim</td>
</tr>
<tr>
<td>6</td>
<td>Blood Stain</td>
<td>5 µL on filter paper</td>
</tr>
<tr>
<td>7</td>
<td>Blood Stain</td>
<td>5 µL spiked with inhibitor mix on fabric</td>
</tr>
<tr>
<td>8</td>
<td>Semen Stain</td>
<td>1 µL on fabric</td>
</tr>
</tbody>
</table>
Results

The Quantifiler® Duo Kit reactions performed on the case-type samples yielded a range of DNA concentrations from 0.31 ng/µL to 14.66 ng/µL for the SRY male-specific target and from 0.27 ng/µL to 13.28 ng/µL for the RPPH1 human target (Table 6-9).

Table 6-9  Quantifiler® Duo Quantification Kit reactions performed on case-type samples

<table>
<thead>
<tr>
<th>Sample #</th>
<th>Extraction Method</th>
<th>Vendor</th>
<th>Quantity (SRY) ng/µL</th>
<th>Quantity (RPPH1) ng/µL</th>
<th>C&lt;sub&gt;T&lt;/sub&gt; Value (IPC)</th>
<th>SRY-RPPH1 % difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Organic</td>
<td>In House</td>
<td>2.060</td>
<td>2.010</td>
<td>29.74</td>
<td>2.5</td>
</tr>
<tr>
<td>2</td>
<td>Organic</td>
<td>In House</td>
<td>11.000</td>
<td>11.350</td>
<td>29.77</td>
<td>-3.1</td>
</tr>
<tr>
<td>3</td>
<td>Organic</td>
<td>In House</td>
<td>0.820</td>
<td>0.908</td>
<td>29.84</td>
<td>-9.7</td>
</tr>
<tr>
<td>4</td>
<td>Organic</td>
<td>In House</td>
<td>2.090</td>
<td>2.070</td>
<td>29.68</td>
<td>1.0</td>
</tr>
<tr>
<td>5</td>
<td>Organic</td>
<td>In House</td>
<td>1.370</td>
<td>0.757</td>
<td>32.54</td>
<td>81.0</td>
</tr>
<tr>
<td>6</td>
<td>Organic</td>
<td>In House</td>
<td>1.350</td>
<td>1.340</td>
<td>29.48</td>
<td>0.7</td>
</tr>
<tr>
<td>7</td>
<td>Organic</td>
<td>In House</td>
<td>1.840</td>
<td>1.720</td>
<td>29.69</td>
<td>7.0</td>
</tr>
<tr>
<td>8</td>
<td>Organic</td>
<td>In House</td>
<td>1.780</td>
<td>1.820</td>
<td>29.47</td>
<td>-2.2</td>
</tr>
<tr>
<td>1</td>
<td>Chelex</td>
<td>In House</td>
<td>0.506</td>
<td>0.505</td>
<td>28.91</td>
<td>0.2</td>
</tr>
<tr>
<td>2</td>
<td>Chelex</td>
<td>In House</td>
<td>14.660</td>
<td>13.280</td>
<td>29.00</td>
<td>10.4</td>
</tr>
<tr>
<td>3</td>
<td>Chelex</td>
<td>In House</td>
<td>0.307</td>
<td>0.267</td>
<td>30.79</td>
<td>15.0</td>
</tr>
<tr>
<td>4</td>
<td>Chelex</td>
<td>In House</td>
<td>0.425</td>
<td>0.332</td>
<td>30.88</td>
<td>28.0</td>
</tr>
<tr>
<td>1</td>
<td>Silica Membrane</td>
<td>QIAGEN, Blood kit</td>
<td>0.457</td>
<td>0.443</td>
<td>29.90</td>
<td>3.2</td>
</tr>
<tr>
<td>2</td>
<td>Silica Membrane</td>
<td>QIAGEN, Blood kit</td>
<td>4.020</td>
<td>3.880</td>
<td>29.80</td>
<td>3.6</td>
</tr>
<tr>
<td>3</td>
<td>Silica Membrane</td>
<td>QIAGEN, Blood kit</td>
<td>0.306</td>
<td>0.312</td>
<td>29.76</td>
<td>-1.9</td>
</tr>
<tr>
<td>4</td>
<td>Silica Membrane</td>
<td>QIAGEN, Blood kit</td>
<td>0.522</td>
<td>0.517</td>
<td>29.73</td>
<td>1.0</td>
</tr>
<tr>
<td>1</td>
<td>Magnetic Beads</td>
<td>Promega, DNA IQ</td>
<td>0.732</td>
<td>1.840</td>
<td>29.59</td>
<td>-60.2</td>
</tr>
<tr>
<td>2</td>
<td>Magnetic Beads</td>
<td>Promega, DNA IQ</td>
<td>2.620</td>
<td>9.760</td>
<td>29.80</td>
<td>-73.2</td>
</tr>
<tr>
<td>3</td>
<td>Magnetic Beads</td>
<td>Promega, DNA IQ</td>
<td>0.645</td>
<td>0.715</td>
<td>29.60</td>
<td>-9.8</td>
</tr>
<tr>
<td>4</td>
<td>Magnetic Beads</td>
<td>Promega, DNA IQ</td>
<td>1.140</td>
<td>1.460</td>
<td>29.42</td>
<td>-21.9</td>
</tr>
</tbody>
</table>
For all samples extracted using the organic extraction method, human and male DNA quantities were similar except for the blood stain on denim (Table 6-8, sample 5). For this sample the quantity of male DNA was 81% higher than the quantity obtained from the human target (Table 6-9). The blood stain on denim is a challenging sample due to inhibitors present on the denim substrate and in the blood. The lower quantity of total human DNA may result from inhibition of the amplification of the RPPH1 target. The presence of PCR inhibitors is suggested by the greater C_T value obtained for the IPC.

For the other extraction methods, the human and male DNA quantities for all samples were similar except for the saliva swabs (Table 6-8, samples 1 and 2) extracted with the Promega DNA IQ™ Kit (Table 6-9).

Complete and interpretable STR profiles were obtained for all the samples analyzed. Peak heights from 500 to 4000 rfu were obtained for samples analyzed using the Identifiler® Kit (DNA target amount was 1 ng/rxn), and from 200 to 2000 rfu for samples analyzed using the MiniFiler™ Kit (DNA target amount was 0.1 ng/rxn).

Representative STR profiles obtained for the phenol-chloroform extracted samples are shown in Figure 6-21 and Figure 6-22.
Figure 6-21  STR analysis using the Identifiler® Kit and organic extracted case-type samples

Legend: The sample numbers to the left of the figure refer to the sample numbers in Table 6-5.
**Population Studies (Std. 2.7)**

Human DNA samples from three population groups were analyzed to verify the ability to obtain male and human quantification results using the Quantifiler® Duo kit.

**Experiment**

Purified genomic DNA samples from 534 human individual donors from Hispanic, Caucasian, and African American population groups were analyzed using the Quantifiler® Duo DNA Quantification Kit.

All DNA samples were previously extracted from blood specimens using the Applied Biosystems BloodPrep® DNA Chemistry and ABI PRISM® 6100 Nucleic Acid PrepStation. The samples were previously quantified using the Quantifiler® Human DNA Quantification Kit.
Developmental Validation

The number of male and female samples, in each of the population groups tested, is detailed in Table 6-10. Approximately 1 ng of purified genomic DNA was used from the panel for each Quantifiler® Duo Kit reaction.

### Table 6-10  Distribution of samples used for population studies

<table>
<thead>
<tr>
<th>Population</th>
<th>Male Samples</th>
<th>Female Samples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caucasian</td>
<td>130</td>
<td>60</td>
</tr>
<tr>
<td>African-American</td>
<td>116</td>
<td>24</td>
</tr>
<tr>
<td>Hispanic</td>
<td>129</td>
<td>75</td>
</tr>
<tr>
<td>Total/gender</td>
<td>375</td>
<td>159</td>
</tr>
<tr>
<td>Total</td>
<td>534</td>
<td></td>
</tr>
</tbody>
</table>

### Results

The Quantifiler® Duo DNA Quantification Kit detected and quantified DNA in all 534 human DNA samples.

- All 375 male DNA samples exhibited the SRY signal (see Table 6-11).
- The SRY signal was not detected for any of the female samples tested (see Table 6-11).
- The human-male DNA quantity value (SRY) was within ± 25% of the total human quantity value (RPPH1) obtained for most of the male samples (data not shown).
- 5 of the 375 male samples tested (Table 6-12) yielded SRY quantity values that deviated from the RPPH1 quantity values by > 25%. This may have resulted from duplication of the SRY gene in these DNA samples.
Mixture Study (Std. 2.8)

The mixture studies were designed to simulate circumstances in which a small component of male DNA must be discerned from a high background of female DNA. When interpreting results, consider that evidence samples may contain DNA from more than one individual.

Experiment 1

Mixture samples containing 0.2 ng/µL of human male DNA and varying amounts of female DNA were prepared. The ratio of male and female DNA in these samples was 1:0, 1:1, 1:5, 1:10, 1:20 and 0:1 (Table 6-13). The mixture samples were processed in triplicate using the Quantifiler® Duo DNA Quantification Kit to determine the concentration of total human DNA (RPH1 target) and male DNA (SRY target).
In addition, using the results from the RPPH1 human target, approximately 1.0 ng of human genomic DNA from each sample was added to an Identifiler® Kit reaction. Using the results from the SRY male target, approximately 1.0 ng of human genomic DNA from each sample was added to a Yfiler® kit reaction.

**Results 1**

The quantification results obtained using the Quantifiler® Duo DNA Quantification Kit are summarized in Table 6-13 and shown graphically in Figure 6-23. For all samples, the male DNA produced consistent quantification values, regardless of the amount of female DNA present. Thus, the ability to quantify the male DNA was not adversely affected by the presence of the quantities of female DNA investigated.

In addition, the ratios of male and female DNA in the mixture samples derived from the quantification results correlated well with the expected ratios.

<table>
<thead>
<tr>
<th>Expected Male/Female DNA Ratio</th>
<th>SRY Quantity ng/µL</th>
<th>RPPH1 Quantity ng/µL</th>
<th>Measured Male: Female DNA Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:0</td>
<td>0.228</td>
<td>0.236</td>
<td>1:0.04</td>
</tr>
<tr>
<td>1:1</td>
<td>0.229</td>
<td>0.507</td>
<td>1:1.21</td>
</tr>
<tr>
<td>1:5</td>
<td>0.240</td>
<td>1.410</td>
<td>1:4.88</td>
</tr>
<tr>
<td>1:10</td>
<td>0.280</td>
<td>3.030</td>
<td>1:9.82</td>
</tr>
<tr>
<td>1:20</td>
<td>0.235</td>
<td>4.070</td>
<td>1:16.32</td>
</tr>
<tr>
<td>0:1 Female</td>
<td></td>
<td>0.217</td>
<td>-----</td>
</tr>
</tbody>
</table>
Figure 6-23  Mixture Study 1: Quantification values obtained for a constant amount of male DNA in a background of increasing female DNA

Based on the results from the RPPH1 target, approximately 1.0 ng of human genomic DNA from each sample was analyzed using the Identifiler® Kit (Figure 6-24). As expected, the peak height of male alleles decreased with increases in the ratio of female to male DNA, reflecting the reducing amount of male DNA present in each sample.

Interpretation of the minor male profile in such mixture samples was challenging due to the occurrence of shared alleles (minor-male alleles at stutter positions of female alleles) and dropout of minor alleles. Alleles from the minor male contributor were interpretable in the mixture samples having 1:1, 1:5 and 1:10 ratios of male:female DNA, as indicated by the arrows in Figure 6-24.
Figure 6-24  Mixture study 1: STR analysis using the Identifiler<sup>®</sup> Kit

Top panel: Male contributor DNA profile. Bottom panel: Female contributor DNA profile. Middle panels: Male:female DNA mixtures. Arrow denotes male contributor alleles at one locus.
Based on the results from the SRY target, approximately 1.0 ng of human male DNA from each sample was profiled using the Yfiler® Kit (Figure 6-25). The Yfiler® Kit amplifies STR targets on the human Y-chromosome only. Therefore, one would expect a good correlation between the quantification values obtained from the SRY target in the Quantifiler® Duo DNA Quantification Kit and the performance of the Yfiler® Kit. Complete, conclusive, and consistent male profiles were obtained from all mixture samples investigated.

Figure 6-25  Mixture Study 1: STR analysis using the Yfiler® Kit
Experiment 2

The limit of detection of male DNA in the presence of large excesses of female DNA was studied. Mixture samples were prepared containing 25 pg/µL of male DNA and increasing quantities of female DNA, resulting in M:F ratios of 1:0, 1:50, 1:100, 1:200, 1:500, 1:800, 1:1000 and 0:1. The mixture samples were processed in triplicate using the Quantifiler® Duo DNA Quantification Kit to determine the concentration of total human genomic DNA (RPPH1 target) and male DNA (SRY target).

Based on the results from the SRY male target, approximately 1.0 ng of human genomic DNA from each sample was added to a Yfiler® Kit reaction.

Results 2

The male DNA was detected and quantified in all mixture samples with as high as a 1:1000 M:F ratio using the Quantifiler® Duo DNA Quantification Kit (Table 6-14 and Figure 6-26). Detection of male DNA as low as 25 pg/µL in the presence of 1000-fold excess female DNA demonstrates the robustness and specificity of the Quantifiler® Duo DNA Quantification Kit. The observed ratio of the male and female DNA varied between 10% to 40% from the expected ratio most likely because of stochastic variations in the PCR.

Table 6-14  Mixture study 2: ratio and quantification results

<table>
<thead>
<tr>
<th>Male/Female DNA Ratio</th>
<th>SRY Quantity ng/µL</th>
<th>RPPH1 Quantity ng/µL</th>
<th>Measured Male : Female DNA Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:0</td>
<td>0.027</td>
<td>0.026</td>
<td>1:0.04</td>
</tr>
<tr>
<td>1:50</td>
<td>0.029</td>
<td>1.260</td>
<td>1:42.45</td>
</tr>
<tr>
<td>1:100</td>
<td>0.029</td>
<td>2.460</td>
<td>1:83.25</td>
</tr>
<tr>
<td>1:200</td>
<td>0.022</td>
<td>6.405</td>
<td>1:288.16</td>
</tr>
<tr>
<td>1:500</td>
<td>0.025</td>
<td>13.770</td>
<td>1:545.43</td>
</tr>
<tr>
<td>1:800</td>
<td>0.027</td>
<td>24.410</td>
<td>1:896.43</td>
</tr>
<tr>
<td>1:1000</td>
<td>0.020</td>
<td>28.210</td>
<td>1:1388.66</td>
</tr>
<tr>
<td>0:1</td>
<td>Female</td>
<td>0.016</td>
<td>-----</td>
</tr>
</tbody>
</table>
Based on the results from the SRY target, the maximum allowed volume (10 µL) of each mixture sample was profiled using the Yfiler® Kit (Figure 6-27). Complete, conclusive and consistent male profiles were obtained from all mixture samples investigated. The results demonstrate the utility of the Quantifiler® Duo DNA Quantification Kit in the analysis of mixture samples.
Developmental Validation

Quantifiler® Duo DNA Quantification Kit User’s Manual 6-49

Figure 6-27 Mixture study 2: STR analysis using the Yfiler® Kit

Precision and Accuracy (Std. 2.9)

The precision and accuracy of the Quantifiler® Duo Kit was assessed by replicate standard curve analysis.

Experiment

The precision of the Quantifiler® Duo DNA Quantification Kit was tested by performing two runs on different days (one run per day) on three different instruments.

One set of eight serial dilutions was prepared containing 50, 16.7, 5.56, 1.85, 0.62, 0.21, 0.068 and 0.023 ng/µL of the human male DNA standard included in the Quantifiler® Duo DNA Quantification Kit. Six reaction plates were set up and each of them contained 10 replicates of the 8 dilutions. Two plates per instrument were run on three different 7500 Real-time PCR System instruments using recommended thermal cycler conditions for the Quantifiler® Duo DNA Quantification Kit.
The two runs were performed on two different days, using the same three 7500 Real-Time PCR System instruments. For each dilution, the \( C_T \) values for RPH1 (VIC), SRY (FAM) and IPC (NED) signals were recorded for all 60 reactions. Slope, \( R^2 \) and Y-intercept values were also computed.

**Results**

Table 6-15 shows the means and standard deviations of the \( C_T \) values for RPH1, SRY, and IPC targets calculated for each quantification standard dilution across all 6 plates.

<table>
<thead>
<tr>
<th>Quantification Standard Dilution (ng/µL)</th>
<th>Human</th>
<th>Male</th>
<th>IPC</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>( C_T ) (Mean)</td>
<td>Standard Deviation</td>
<td>( C_T ) (Mean)</td>
</tr>
<tr>
<td>50</td>
<td>23.36</td>
<td>0.26</td>
<td>23.92</td>
</tr>
<tr>
<td>16.7</td>
<td>24.98</td>
<td>0.23</td>
<td>25.55</td>
</tr>
<tr>
<td>5.56</td>
<td>26.62</td>
<td>0.28</td>
<td>27.22</td>
</tr>
<tr>
<td>1.85</td>
<td>28.26</td>
<td>0.23</td>
<td>28.88</td>
</tr>
<tr>
<td>0.62</td>
<td>29.79</td>
<td>0.29</td>
<td>30.44</td>
</tr>
<tr>
<td>0.21</td>
<td>31.32</td>
<td>0.34</td>
<td>32.01</td>
</tr>
<tr>
<td>0.068</td>
<td>32.83</td>
<td>0.32</td>
<td>33.61</td>
</tr>
<tr>
<td>0.023</td>
<td>34.48</td>
<td>0.58</td>
<td>35.33</td>
</tr>
</tbody>
</table>

Figure 6-28, Figure 6-29, and Figure 6-30 provide the human, human male, and IPC \( C_T \) mean values obtained using the Quantifiler® Duo DNA Quantification Kit.
Developmental Validation

Figure 6-28  Precision using the Quantifiler® Duo DNA Quantification Kit (RPPH1 human target) at the standard curve concentrations

Figure 6-29  Precision using the Quantifiler® Duo DNA Quantification Kit (SRY male target) at the standard curve concentrations
For each sample, the $C_T$ values obtained for the RPPH1 target were lower than those obtained for the SRY target because there are two copies of the autosomal human target locus and only one copy of the Y chromosome target locus per genome equivalent.

The $C_T$ values did not vary significantly from run to run or from instrument to instrument. The data showed that at lower DNA concentrations, the standard deviations increased, most likely due to stochastic effects.

Systematic differences between instruments are not expected to affect final sample quantification results; when samples and quantification standards are run on the same plate and instrument, the $C_T$ values are affected proportionately.
Optimization of PCR Reaction Conditions (Std. 2.10.1) & Effect of Coamplification in Multiplex PCR (Std. 2.10.3)

The quantities of critical reagents in the PCR mix such as primers, probes, and IPC template were optimized using the following thermal cycling conditions:

- Hold: 50°C 2 min.
- Hold: 95°C 10 min.
- Cycle: 95°C 15 sec, 60°C 1 min for 40 cycles.

The primers and probes for amplification and detection of RPPH1, SRY, and IPC targets were investigated at concentrations ranging from 50 to 725 nM. In a separate experiment, copies of the IPC varied from 1,000 to 40,000 copies per assay.

Contamination (Std. 3.6)

Analysis of non-template control samples was performed to demonstrate that the Quantifiler® Duo assay did not generate results due to the presence of contaminating DNA.

Experiment

To test for contamination, all standard assay parameters were used, except that the number of cycles was extended from 40 to 50 in the PCR amplification cycling step.

A 96-well plate was set up with 95 non-template controls (NTCs) and one positive control sample (at a concentration of approximately 20 ng/µL). The number of PCR cycles was increased from 40 to 50 in this experiment to study the performance at a higher stringency.

Results

None of the 95 NTCs exhibited any detectable signal for the human and male targets in the VIC and FAM channels, respectively (Figure 6-31). The $C_T$ values for the IPC signal (NED) fell within a range of variation of 1 $C_T$, which is within the normal variation of the TaqMan® assay. The positive control sample provided the expected $C_T$ values for human and male targets.
Chapter 6  Experiments and Results

Figure 6-31  NTC and positive control

Correlation Studies
Quantification of DNA is a step in the STR analysis workflow that provides a value obtained by measuring the DNA content of a given sample against a reference (standard DNA sample). Quantification results may vary based on the method used; e.g., UV absorbance, binding of intercalating dyes, hybridization, PCR, and so on.

Among the different PCR-based quantification methods, the quantity of DNA obtained for any given sample may vary due to different aspects of PCR (see Results section below). The ultimate goal of the DNA quantification step in the STR analysis workflow is not to obtain an absolute value, but to determine the volume of the DNA extract to be used for amplification to produce high quality STR genotyping results.

Experiment
Four male genomic DNA samples (A through D) and one female genomic DNA sample (sample E) at 20.0, 10.0, 1.0, 0.1 and 0.05 ng/µL were quantified in triplicate using the Quantifiler® Duo, Quantifiler® Human and Quantifiler® Y Human Male Quantification Kits.
Results

All male samples provided quantification results for both human and male targets using the Quantifiler® Duo, Quantifiler® Human and Quantifiler® Y Human Male DNA Quantification Kits (Table 6-16). No detectable male target signal was obtained for the female DNA sample, at any concentration, using the Quantifiler® Duo and Quantifiler® Y Human Male DNA Quantification Kits. The quantities of human and male DNA obtained from the Quantifiler® Duo DNA Quantification Kit were similar to the quantities obtained using either the Quantifiler® Human or Quantifiler® Y Human Male DNA Quantification Kit.

The differences in the quantities of DNA obtained in the present experiment may be due to one or more of the following:

- The difference in the amplification targets used for quantification of human DNA: RPPH1 in the Quantifiler® Duo DNA Quantification Kit and hTERT in the Quantifiler® Human DNA Quantification Kit.
- The difference in the sizes of the human DNA targets: 140 bases in the Quantifiler® Duo DNA Quantification Kit and 62 bases in the Quantifiler® Human DNA Quantification Kit.
- The difference in the sizes of the male DNA targets: 130 bases in the Quantifiler® Duo DNA Quantification Kit and 64 bases in the Quantifiler® Y Human Male DNA Quantification Kit; though in both kits the male target is SRY gene.
- The differences in assay complexity: the Quantifiler® Duo DNA Quantification Kit is a triplex PCR assay, and the Quantifiler® Human and Quantifiler® Y Human Male DNA Quantification Kits are duplex PCR assays.
- Differences in the quantification standards used in the respective kits: human male genomic DNA in the Quantifiler® Duo DNA Quantification Kit; cell line DNA in the Quantifiler® Human and Quantifiler® Y Human Male DNA Quantification Kits.
- Differences in the optimized reaction mix: each PCR reaction mix is optimized to deliver the expected performance for a given kit.

Applied Biosystems recommends that laboratories determine the optimum amount of input DNA required for each STR genotyping system based on the quantification values obtained using the Quantifiler® Duo DNA Quantification Kit.
### Table 6-16  Correlation of DNA quantification using the Quantifiler® Duo, Quantifiler® Human and Quantifiler® Y Human Male Quantification Kit

<table>
<thead>
<tr>
<th>Sample</th>
<th>Expected Quantity</th>
<th>Mean Quantity Human</th>
<th>Mean Quantity Male</th>
<th>% difference</th>
<th>% difference</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>ng/µL</td>
<td>Quantifiler Duo</td>
<td>Quantifiler Human</td>
<td>Mean difference</td>
<td>Quantifiler Duo</td>
</tr>
<tr>
<td>A</td>
<td>10.000</td>
<td>9.110</td>
<td>10.440</td>
<td>-12.739</td>
<td>8.983</td>
</tr>
<tr>
<td>A</td>
<td>1.000</td>
<td>0.869</td>
<td>0.831</td>
<td>4.573</td>
<td>0.854</td>
</tr>
<tr>
<td>A</td>
<td>0.100</td>
<td>0.091</td>
<td>0.071</td>
<td>28.169</td>
<td>0.083</td>
</tr>
<tr>
<td>A</td>
<td>0.050</td>
<td>0.043</td>
<td>0.044</td>
<td>-2.273</td>
<td>0.046</td>
</tr>
<tr>
<td>B</td>
<td>1.000</td>
<td>1.143</td>
<td>1.080</td>
<td>5.833</td>
<td>1.147</td>
</tr>
<tr>
<td>B</td>
<td>0.100</td>
<td>0.104</td>
<td>0.098</td>
<td>6.122</td>
<td>0.110</td>
</tr>
<tr>
<td>B</td>
<td>0.050</td>
<td>0.061</td>
<td>0.044</td>
<td>38.636</td>
<td>0.049</td>
</tr>
<tr>
<td>C</td>
<td>1.000</td>
<td>0.822</td>
<td>1.010</td>
<td>-18.614</td>
<td>0.894</td>
</tr>
<tr>
<td>C</td>
<td>0.100</td>
<td>0.098</td>
<td>0.129</td>
<td>-24.031</td>
<td>0.108</td>
</tr>
<tr>
<td>C</td>
<td>0.050</td>
<td>0.044</td>
<td>0.056</td>
<td>-21.429</td>
<td>0.044</td>
</tr>
<tr>
<td>D</td>
<td>20.000</td>
<td>27.283</td>
<td>16.730</td>
<td>63.078</td>
<td>26.487</td>
</tr>
<tr>
<td>D</td>
<td>1.000</td>
<td>1.217</td>
<td>1.470</td>
<td>-17.211</td>
<td>1.263</td>
</tr>
<tr>
<td>D</td>
<td>0.100</td>
<td>0.118</td>
<td>0.100</td>
<td>18.000</td>
<td>0.121</td>
</tr>
<tr>
<td>D</td>
<td>0.050</td>
<td>0.059</td>
<td>0.066</td>
<td>-10.606</td>
<td>0.073</td>
</tr>
<tr>
<td>E</td>
<td>20.000</td>
<td>24.910</td>
<td>27.880</td>
<td>-10.653</td>
<td>female</td>
</tr>
<tr>
<td>E</td>
<td>10.000</td>
<td>12.107</td>
<td>13.270</td>
<td>-8.764</td>
<td>female</td>
</tr>
<tr>
<td>E</td>
<td>1.000</td>
<td>1.137</td>
<td>1.300</td>
<td>-12.538</td>
<td>female</td>
</tr>
<tr>
<td>E</td>
<td>0.100</td>
<td>0.116</td>
<td>0.162</td>
<td>-28.395</td>
<td>female</td>
</tr>
<tr>
<td>E</td>
<td>0.050</td>
<td>0.056</td>
<td>0.060</td>
<td>-6.667</td>
<td>female</td>
</tr>
</tbody>
</table>
Bibliography


Index

Numerics

5′ nuclease assay 1-3, 1-4
7500 Real-time PCR System
  fluorescence detection on 1-7, 1-8
  PCR instrument 1-9
  reactions, running on 3-7
  starting 2-3
  supported configuration 2-2
  target nucleic acid, relative quantity of 1-9
7500 SDS
  analysis settings, checking 5-2
  baseline settings 4-3
  detectors, creating 2-10
  detectors, settings 5-2
  fluorescence emission data 1-7
  New Document dialog box 2-9
  plate document, analyzing 4-2
  product registration 2-5
  results, viewing 4-4
  template, setting up 2-26
  threshold settings 4-3
9600 Emulation box
  selection on the 7500 SDS 2-24

A

amplification plot
  about 1-9
  example 1-9
  inconsistent replicates, example of 5-15
  jagged plot, example of 5-16
  phases of 1-10
  troubleshooting 5-15
  undefined plots, example of 5-16
  viewing 4-6
analysis settings
  checking on the 7500 SDS 5-2
  verifying on the 7500 SDS 4-3

Applied Biosystems
  contacting xi
  customer feedback on documentation xi
  Information Development department xi
  Services and Support xi
  Technical Support xi

B

baseline
  about 1-13
  settings for the 7500 SDS 4-3
biohazard warning x
biohazardous waste, handling x
biological hazard safety. See biohazard warning
bold text, when to use v

C

CAUTION, description vii
chemical safety guidelines viii
chemical waste hazards ix
  safety guidelines ix
cleavage, in 5′ nuclease assay 1-5
computer, starting
  for the 7500 Real-time PCR System 2-3
contents of kit 1-16
conventions
  bold text v
  for describing menu commands v
  IMPORTANTS! vi
  in this guide v
  italic text v
  Notes vi
  user attention words vi
C(T. See threshold cycle
customer feedback, on Applied Biosystems documents xi
D
DANGER, description vii

data collection 1-8
detectors (7500 SDS)
  adding to plate document 2-16
  analysis settings for 5-2
  creating 2-10
DNA quantification standards
  dilution series, guidelines for 3-2
  guidelines for preparing 3-4
  materials required to prepare 3-2
  omitting Std. 8 5-4
  preparing 3-4
  reaction recommendation 3-6
See also standards
DNA standard curve 1-6
documentation, related xi

E
equipment, not included with Quantifiler kits 1-17
exponential phase. See geometric phase
exporting data analysis results 4-8

F
fluorescence, detection of 1-7

G
geometric phase, amplification plot 1-10
guidelines
  chemical safety viii
  chemical waste safety ix
  waste disposal x

H
hazards
  biological x
  chemical waste ix
human DNA standard
  alternate standard curve 1-6
  DNA standard curve 1-6
  human male genomic DNA 1-6

I
IMPORTANT, description vii
Information Development department, contacting xi
instrument, powering on
  for the 7500 Real-time PCR System 2-4
Internal PCR Control system, See IPC system
IPC system
  about assay 1-3
  components 5-13
  interpreting results of 5-13
  invalid results from 5-14
italic text, when to use v

K
kit contents, Quantifiler 1-16

L
linear phase, amplification plot 1-11

M
manuals. See documentation, related
materials, not included with Quantifiler kits 1-17
menu commands, conventions for describing v
minor groove binder, description 1-4
MSDSs
  description viii
  obtaining viii, xi
  referring to viii, ix

N
negative results 5-14
New Document dialog box (7500 SDS) 2-9
nonfluorescent quencher, description 1-4

O
Optical Adhesive Cover, sealing plate with 3-6
P
passive reference
normalization using 1-9
selecting in Well Inspector (7500 SDS) 2-21

PCR
kinetic analysis of 1-9
partial inhibition 5-14
phases of 1-10
process in 5' nuclease assay 1-4
reactions, preparing 3-5
standard, preparing 3-2

plate document (7500 SDS)
analyzing 4-2
creating blank 2-9
creating from a template 2-28
detectors, adding 2-16
detectors, creating 2-10
how used 2-6
saving 2-25
setting up 2-8
setup examples 2-7
template, creating 2-26
template, setting up 2-26
thermal cycler conditions, setting 2-24
types 2-6
plateau phase, amplification plot 1-11
polymerization, in 5’ nuclease assay
completion of 1-6
process 1-4
probes, about 1-4
pure-dye calibration 1-8

Q
Quantifiler Kit contents 1-16
quantity
assessing 5-19
exporting (7500 SDS) 4-8
printing (7500 SDS) 4-8

R
R² value
interpreting 5-3
viewing (7500 SDS) 4-4
radioactive waste, handling x
raw data
printing (7500 SDS) 4-8
reactions
examples of arranging 2-7
real-time data analysis 1-9
regression line formula 5-3
report
viewing on the 7500 SDS 4-6
reporter signal, normalized
about 1-9
viewing in amplification plot (7500 SDS) 4-5
results
viewing (7500 SDS) 4-4
R_n. See reporter signal, normalized
ROX
selecting in Well Inspector (7500 SDS) 2-21

S
safety
biological hazards ix
chemical waste ix
safety alert words
CAUTIONS vii
DANGERS vii
description vii
IMPORTANTS vii
WARNINGS vii
SDS document. See *.sds file
*.sds file
description (7500 SDS) 2-6
saving (7500 SDS) 2-25
SDS software
starting for 7500 Real-time PCR System 2-5
SDS template. See *.sdt file
*.sdt file
description (7500 SDS) 2-6
saving (7500 SDS) 2-27
See also template
Services and Support, obtaining xi
slope of standard curve
Index-4

Quantifier® Duo DNA Quantification Kit User’s Manual

about 5-3
interpreting 5-4
outside typical range 5-5
viewing (7500 SDS) 4-4

standard curve
about results 5-3
differences in \( C_T \) values of replicates 5-10
interpreting 5-3
outlier in, example of 5-9
print setup (7500 SDS) 4-8
replicates, example of four 5-10
straight horizontal line 5-6
troubleshooting 5-5
viewing (7500 SDS) 4-4

standards
applying detectors for (7500 SDS) 2-20
See also DNA quantification standards

stochastic effects 5-19

storage recommendations, for kits 1-16

strand displacement, in 5´ nuclease assay 1-5

T
TaqMan®
fluorescent probes 1-12
MGB probes 1-4
RNase P Instrument Verification Plate 1-12

targets, about 1-3

Technical Support, contacting xi

template
creating plate document from (7500 SDS) 2-28
saving (7500 SDS) 2-27
setting up for plate documents (7500 SDS) 2-26

text conventions v

thermal cycler conditions
setting (7500 SDS) 2-24

threshold
settings for the 7500 SDS 4-3

threshold cycle
calculation of 1-13
exporting (7500 SDS) 4-8
in standard curve 5-3

normal range for IPC system 5-14

printing (7500 SDS) 4-8
relationship to initial template amount 1-13

viewing in amplification plot (7500 SDS) 4-5

viewing in standard curve (7500 SDS) 4-4

training, information on xi

U

user attention words, described vi

V

validation
importance of 6-2
validation studies 6-3

W

WARNING, description vii

waste disposal, guidelines x

Y

y-intercept of standard curve
interpreting 5-3
viewing (7500 SDS) 4-4
Headquarters
850 Lincoln Centre Drive
Foster City, CA 94404 USA
Phone: +1 650.638.5800
Toll Free (In North America): +1 800.345.5224
Fax: +1 650.638.5884

Worldwide Sales and Support
Applied Biosystems vast distribution and service network, composed of highly trained support and applications personnel, reaches 150 countries on six continents. For sales office locations and technical support, please call our local office or refer to our Web site at www.appliedbiosystems.com.

www.appliedbiosystems.com

Applied Biosystems is committed to providing the world’s leading technology and information for life scientists.

Printed in the USA, 03/2012
Part Number 4391294 Rev. D